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CHAPTER 1

Getting Started

Welcome to the FontWorks embroidery design system for embroidery
machines. The FontWorks User’s Guide provides you with the information
you need to learn about and begin using FontWorks.

In this chapter:

« Find out some basic information about FontWorks.
+ Learn how to install FontWorks.
» Activating the software, once it is installed.
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Getting Started

FontWorks System
Requirements

Specifications are subject to change without

' prior notice. For additional information on setup

and system requirements, contact your
distributor.

L

Recommended System Requirements:

« Genuine Intel Pentium 4, 2GHz PC computer
(or higher) with a CD-ROM drive.

» 2 gigabytes of RAM.

»  Microsoft® Windows® 7/8/10 operating
system

=  Minimum 1 gigabyte hard disk drive space
available

Installing the
Application

When you first insert the FontWorks CD, the
Installer program will start automatically. A
welcome screen will open, asking you to
continue installing FontWorks or Cancel if you
wish to install at a |later date
You must be running Windows® 7/8/10 to
install FontWorks. Your computer’s operating

-
_,‘ system must be up to date with the most cur-
rent system updates and service packs.

Installing the FontWorks
Software

To install FontWorks:

1 Insert the FontWorks CD into the CD-ROM
drive.
The FontWorks Installer Welcome screen
appears on your desktop.

2 Choose “Install FontWorks” to proceed with

the software installation.

You see the InstallShield introductory screen.
InstallShield is an installation wizard that will
guide you through the installation process.

W Designer's Gallery FontWorks - InstalShield Wizard

Welcome to the InstaliShledd Wizard for
Designer's Gallery FontWorks

The InstaliShiekd(R) Wizard will install Designer's Gallery |
FontWorks on your computer, To continue, dick Next.

WARNING: This program is protected by copyright law and
international treaties.

3 Click Next to begin the installation.
You see the Licence Agreement screen.

4 Designer's Gallery FontWorks - InstallShield Wizard ]

License Agreement
Please read the following license agreement carefully.

www NOTICE #w«= |

This software has been provided pursuant to a "CUSTCMER |
SOFTWARE LICENSE AGREEMENI™ set forth on the packaging
&l {(reproduced below) (the "License Agreement”)

I
= what you may do with the software and contains ||
sTi0n2 on warranties and/or remedies. The software

is

protscted by copyright, patent, trade gsecret and II

e rm———

1@ [ accept the terms in the license agreement

1~ I do not accept the terms in the license agreement |‘
i

I\ ™ Cancel

L

4 After reading the license agreement, click the
radio button next to “l accept the terms of the
license agreement, and click Next.

You see the Customer Information screen.



ﬁ Designer's Gallery FontWorks - InstaliShield Wizard

px9
Customer Information
Please enter your mnformation.
LUser Name:

Orgariaation:

Irstall this application for:
@' Anyona who uses this computer (2l users)
" Only for me (BigHoncho)

InstaliShield

|
|
|
79 .
4

[ <ok

W=

5 Fill in your name and an organization name
(optional) and click next.
You see the Setup Type screen.

1Y Designer’s Gallery FontWorks - InstaliShield Wizard =

Setup Type

Please select a setup type.

9 Complete

All program features wil be instaled, (Requires the most disk
' space.)

' Custom

i

Choose which program featised you want retaled and where they
il be instadled. Recommendss for advanced users,

| tristalishield

- S —— |
e ) (e )

Choose the setup type that best suits your needs, i !‘

-

On the Setup Type screen, you can leave the

default setting (“Complete”) selected, and
proceed directly to the next step; or, choose
“Custom” to change the location where the
program files will be installed.

By default, the application will be installed in
this folder: Program Files(x86)\ BabyLock\
FontWorks).

6 Click Next.

You see the Ready fo Install the Program
screen.

FONTWORKS
User's Guide

7 Click Install.

The wizard will perform the installation. When
the installation is complete, you see another
wizard screen.

8 Click Finish.

Activating the Software

In order to use the FontWorks software (once it
is installed), you must Activate it first; all you
need for your activation is the activation serial

number that came with your copy of the software.

To obtain an activation:
1 Do one of the following:

+ Double-click the FontWorks icon on your
desktop.

+ Choose Start—-All Programs—Designer’s
Gallery—FontWorks.
You see the activation screen.

X4
Name*:
Address®:
City™:
State: |
Postal Code*: |
Country*:
Emaii*:
Phone*:
Company:
|
* Field is required to continue |
Product: FontWorks 7” l
Activation Serial Number: -
|
‘1 Letigsts n Close_

9
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2 Fill in the required activation information in
the appropriate fields.

' Fields marked with an asterisk (*) are required
- your software will not be activated otherwise.

3 Type your individual activation serial number
(that came with your copy of FontWorks) into
the Activation Serial Number field.

4 Click the Activate Now button on the dialog.
The Activation dialog will close and
FontWorks will open.

If you need to see the Activation Serial Number
again, it can be found in the software. Click the
About button, which displays a dialog which

“ shows copyright information, and includes the
serial number along the bottom.

Activating FontWorks
without an Internet
Connection

If you have installed the software on a computer that
does not have an Internet connection, you will need
a site key (in addition to the serial number) to
complete the activation.

You can obtain the site key by contacting
FontWorks customer support: 1-800-313-4110 or
www.designersgallerysoftware.com/support.

To obtain an activation without an internet
connection:
1 Do one of the following:
+ Double-click the FontWorks lcon on your
desktop.
+ Choose Start—All Programs—Designer’s
Gallery—FontWorks.
You see the registration screen.

Name®:
Address®:
City*:

State:

Postal Code*:
Country*:
Email*:
Phone*:

Company:

* Field is required to continue

Product: FontWorks v

Activation Serial Number:

Close

2 Fill in the registration information in the
appropriate fields.

' Fields marked with an asterisk (*) are required
- your software will not be activated otherwise.

3 Type yourindividual serial number (that came
with your copy of FontWorks) into the serial
number field.

4 Click the Activate Now button on the dialog.
You see a warning message, informing you
that the Activation Server cannot be reached,
because the computer is not connected.

5 Click OK to dismiss the message.

The Activation wizard dialog now shows two
new fields, underneath the Activation Serial
Number: one for the site code, and one for the
site key. Note that the site code field will
already be filled in.

Keep the site code handy - customer support
will require it before giving out the site key.




6 Contact FontWorks customer support to
obtain a site key.

7 Inthe Activation dialog, enter the site key that
you received.

8 Click the Activate Now button.
FontWorks will open.

Deactivating your copy of
FontWorks

Once it has been activated, it is possible to
deactivate the software by re-opening the
activation dialog.

Deactivation effectively ‘frees up’ the Activation
code so that it can be re-used — once you
deactivate the software, it will no longer work on
that computer, and you will be able to transfer it
to a different computer (without using the
additional license from your serial number).

—TN

serial number up to six times.

' You must be connected to the internet to
deactivate the software.

To deactivate FontWorks:

1 Click the Activation icon on the top-right
corner of the workspace.
The Activation Dialog will open, displaying the
user’s personal information and the Activation
code.

2 Click Deactivate.
The Activation dialog will close, and the copy
of FontWorks on this computer will now be
deactivated.

You will be able to deactivate and reactivate youj

FONTWORKS
User's Guide

Opening and Closing
FontWorks

To open FontWorks:
+ Do one of the following:
+ Double-click the FontWorks icon created
on your desktop.
¢ Choose Start—Programs—Designer’s
Gallery—FontWorks.
You see the FontWorks window.

0 ;':—114 B[R 7 Permte el e i PR, Vi Fromst 1), e 124 Ty & St T ..ae'

@ E 1

[

! CATBY

To close FontWorks:

¢ Click the Accelerator ‘f) Button, and select
Exit from the list.

1
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CHAPTER 2

Learning the Basics

Before you start using the software, we recommend that you understand the
FontWorks design workspace and learn a few of the basic components outlined in
this section.

In this chapter:

» Learn the basics such as how to create and alter designs and set up the
design workspace environment.

+ Find out how to open and save designs as well as how to create new
designs.

» Learn how to print designs.
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Understanding the
Workspace

The FontWorks workspace contains several
different areas, each having a distinct function,
The image below shows the FontWorks
workspace.

- L
I 1 Vel Tl Che T Tk gy

@M"ﬁtg -

o
TV "

The sections that follow describe the tools and
functions that are found in each of the main
areas of the FontWorks workspace.

Title Bar

The Title Bar appears at the top of the
FontWorks design window, and shows certain
vital information pertaining to the design. When
you open a design, the design’'s name, recipe
(style), machine format settings, and design
information are displayed in the title bar.

The number of thread colors in a design as well
as its stitch count are automatically updated in
the title bar. A design’s stitch count is consistent
with the stitch count printed or sewn out using
the specified machine format settings.

Accelerator Button
At the top left-hand corner of the window is the

Accelerator button d This button gives you

quick access to a menu of useful tools, such as
New, Save, Print, and several others.
When you open the Accelerator menu, it will
also display a list of files that have recently

been open. Just double-click on the file name
to open it.

For a complete list of the tools available on this
menu, and a summary of their functions, see the
following table.

Tools on the Accelerator list

Tool What it means
‘ 'Tll New: Creates a new untitted design.
- New/Recipe: Opens a new page and
Lag) allows you to choose a new recipe and
machine format.
5 Open Design: Opens an existing
- design file.
; Browser: Opens the Browser dialog,
ﬂ/ which enables you to search your com-
puter’s directories for design files
Merge Design: Opens the Merge Stitch
A File dialog, which you can use to import
N sting sti ine files i
N existing stitch or outline files into the

current design
Save: Saves the current design.

Save as: Opens a Save as dialog,
which allows you to choose the name of
the file, and the place it is saved to.

Closes the current design.

&

Close

Restore ast Opens the latest Autosaved design.

Autosaved

Read from Cardworks Il: If you have a
Read from Cardworks Il box attached to your com-
Cardworks Il puter, allows you to read designs from a

card.




Tool What it means
Send to Cardworks II: If you have a
Send to Cardworks Il box attached to your com-
Cardworks Il puter, allows you to send designs to the
card.
Read from AB Max: If you have an
Read from Amazing Box Max attached to your
AB Max computer, allows you to read designs
from a card.
Send to AB Max: If you have an
Send to Amazing Box Max attached to your
AB Max computer, allows you to send designs to
the card.
Read from Little Max: If you have an
Read from Amazing Box Little Max attached to
Little Max your computer, allows you to read

designs from a card.

Send to Little Max: If you have an
Send to Little Amazing Box Little Max attached to

Max your computer, allows you to send
designs to the card.
Read from Emb Assistant: If you have
Read from A .
Emb an Embroidery Assistant box attached
. to your computer, allows you to read
Assistant .
designs from a card.
Send to Emb Assistant: If you have an
Send to Emb Embroidery Assistant box attached to
Assistant your computer, allows you to send
designs to the card.
5 Print: Click to show printing tools:
= Direct Print, Print Preview, and Print

setup.

Quick Access Toolbar

The Quick Access Toolbar is located at the top of
your workspace, to the left of the Title Bar. This

toolbar holds tool buttons that you will commonly
use, such as Open, Save, and Print; but it is fully
customizabie, so you will be able to add the tools
that you used most often, for easy access. (See
“Customizing the Quick Access Toolbar.”)

P Lepcaswa -
. Home

Tools Preferences

FONTWORKS
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Initially, the following default tools are included
on the Quick Access toolbar: New, New/Recipe,
Open Design, Merge Design, Save, Print
Preview, Undo, and Redo.

Customizing the Quick
Access Toolbar

One important advantage of the Quick Access
toolbar is that it is fully customizable. This means
that you are able to select tools from any of the
FontWorks tabs and add them to the Quick
Access toolbar. You do this by way of the
Customize function, which is accessed by
clicking the small down arrow to the right of the
Quick Access toolbar.

To customize the Quick Access toolbar:

1 Click the down arrow at the right end of the
Quick Access toolbar.
You see a menu.

Customize Quick Access Toolbar
;!/i New

i'/l New/Recipe

'V | Open

}\/{ Merge

V| Save

V| Print Preview
v ! Undo
iV | Redo

More Caommands...

Show Below the Ribbon

Minimize the Ribbon

2 Click on More Commands...
You see the Customize dialog.

15
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3 From the “Choose Commands from” list,
select the toolbar containing the command
you want.

The list of tools on that toolbar now appears in
the “Commands” box.

4 Select the desired tool from within the
“Commands” box, and click Add.

The selected tool appears in the list of Quick
Access toolbar tools.

5 Repeat steps 3-4 until you have added all the
tools you want to the Quick Access toolbar.

6 If there is a tool on the Quick Access toolbar
that you do not want to have on there, select
it in the right-hand box and click on the
Remove button in the dialog.

7 When you have added and/or removed all the
buttons you want, click OK.

The dialog will close; the Quick Access
toolbar will be changed accordingly.

Adding Separators in the Quick
Access Toolbar

You have the option of also adding separators in
the Quick Access Toolbar. These are small
vertical marks which appear on the Quick Access
Toolbar, and divide the commands into groups

for ease of use. A separator is added in the same
way as commands are; select <separator> in the
“Choose commands” list and then click the Add
button.

Here is an example of how the separators work.
If you create an arrangement of separators and
commands in the Customize dialog that iooks
like this:

D New

(3 Open
<Separator:=

) Print

Save
<Separator:

I Undo
Sl Redo

The Quick access toolbar will be organized to
look like this:

w NReB wma) -

— ' - —

| Home : Tools Preferen

For more details, see the procedure outlined in
“Customizing the Quick Access Toolbar.”

You can change the position of a separator, or
any command in the Quick Access Toolbar.
Select it in the box to the right in the Customize
dialog, and click the up and down arrows on
the right. This will move the command or
separator relative to the other commands in the
Quick Access Toolbar.

Customizing Keyboard
Shortcuts

Another useful feature of the More Commands
menu item (on the Quick Access Toolbar) is that
it gives you the option of assigning your own
custom keyboard shortcuts. Keyboard shortcuts



can be very useful for those tools that you use
most often.

To assign keyboard shortcuts:

1 Click the down arrow at the right end of the
Quick Access toolbar.
You see a menu.

Customize Quick Access Toolbar
v | New

New/Recipe

Open

Merge

Save

Print Preview

Undo

S| S| S S &

Redo

More Commands...

Show Below the Ribbon

Minimize the Ribbon

2 Click on More Commands...
You see the Customize dialog.

3 Click the Keyboard button.

You see the Customize Keyboard dialog.

r Customize Keyboard ottt
Categortes: Commands
e ——  — —— | e
Home l-'_'l:n
Tools et Print #
Preferences Ext
Mg
Has
How Recpa
Can
Currert Keys: Press new shoricut key:
Sel Acceleralor for
Delad - |
iy
Descripbon:
Browee for fle
Resel A Close
1 e =
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4 From the Categories list, select the category
containing the command you want.
The corresponding list of commands appears
in the Commands box.

5 Select a command to which you would like to
assign a shortcut.

6 Click in the Press new shortcut key field.

7 On your keyboard, press the sequence of
keys that you want to use; these keystrokes
will appear in the field.

If there are two or more keys used in the
shortcut, a plus sign (+) will be inserted

’I between them, to indicate that they are to be
used in combination. The (+) on your keyboard
is not part of the shortcut sequence.

8 Click the Assign button to create the custom
shortcut.
The shortcut sequence will be moved into the
Current Keys field.

9 Repeat steps 4-8 until you have created all
the desired keyboard shortcuts.

10 Click Close.

Tools on the Ribbon

The ribbon is an area that runs horizontally along
the top of the design workspace.

o @ @ & 3. P

@ 7 Hame Toul View
% X Cut  [Ainsert
[ copy 2X Delete

¥ Fonl\Works - Designl™ (Style: NORMAL, Machi
Preferences
— { ﬂ_' 3
. v . P
BE M A A% A
Text Clrcular Monogram Vertical Text on Textto ord

The Ribbon, with the Home tab displayed

The Ribbon has tabs; these include the Home
tab, the Tools tab, and the Preferences tab.
Under each tab, you will find a set of tools and
settings that have related functions.

The following tables list and briefly describe the
tools that appear under each of these tabs.
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Home Tab

The Home Tab contains all the basic tools for
creating lettering and selecting objects. It also
contains other tools for controlling the display,
the Zoom tool, and the Ruler tool.

Within the Home tab, the tools are further sub-
divided into sections. In some cases, you must
click on the tool heading to display the complete
list of available tools.

Select tools

Tool What it Means

Tool What it Means

E Select: Selects objects in the design win-
dow.

Select All: Click the arrow under the Select
Select Al tool to see the Select All tool, which selects
all items in the design.

Monogram Text: Creates monogram
lettering.

Vertical Text: Creates vertical lettering.

Text on Path: Creates lettering along a
path. The path may be chosen from a pre-
defined list of shapes.

Text to Stairs: Creates a lettering segment
in which the individual letters descend (or
ascend) in a step-wise fashion.

Word Drops: This feature allows you to
create a series of similar designs based on
a single template, by changing only the text
portion of the design. Word Drops will then
output each design in your chosen format.
Font Art: Creates a pattern of words
randomly distributed within a selected
artwork shape in the design.

Clipboard tools

Tool What it means

Display tools

Cut : Cuts the selection and copies it to the
clipboard.

s

1
1

_I'] Copy: Copies the selection to the clipboard.

i e |
L, Paste: Pastes the clipboard contents into the
1 | design, at the end of the design sequence.

- Insert: Pastes a copy of the clipboard

j)'“'_ selection into the sewing sequence
" immediately following the selected segment.
:}'\‘ Delete: Removes the selected segment.

Lettering tools

Tool What it Means
,._f‘. 3D: Realistically renders your design
‘u.,'_’ onscreen.

Grid: Displays a background grid, which
helps with alignment. This grid can be used
for the alignment of items on the display.
When you click the grid button, the current
mode and its cursor remains set.

Hoop: Shows and hides the current hoop in
the workspace. To change the current hoop,
click below this icon, and choose “Select
hoop” from the menu.

Background: This button contains two
options: Background color and Background
fabric. You can change the background color

or fabric pattern for the active design window.

Tool What it Means B
IB Text: Creates lettering placed along a
baseline.
p—
ABC  Circle Text: Creates curved lettering.

Ruler

Tool What it means

Ruler: Measures the distance between any
two points.




Zoom tools
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Tool What it means

Tool What it Means

Zoom in: Magnifies the view of the
design by a fixed amount.

Zoom out: Reduces the size of the view
of the design by a fixed amount.

Zoom to fit: Zooms so that the entire
design will fit in the window.

Zoom 1:1: Returns the design to actual
size.

Zoom slider; Drag to select the degree
of magnification of the design.

Zoom: Magnify parts of your design by
clicking and dragging.

Pan: Allows you to move the design area
around.

Vertical Center: Takes all selected objects
and centers them in the selection box. The
objects are moved so that they are centered
top-to-bottom with each other, but they are
not moved left or right.

Align Center: Centers all selected objects
proportionally in the design workspace.

I Flip Horizontal: Flips one or more selected
. objects horizontally.

Flip Vertical: Flips one or more selected
objects vertically.

% Rotate Left: Rotates one or more selected

objects to the left by 90° increments.

@ Rotate Right: Rotates one or more selected
/ objects to the right by 90° increments.

Tools tab

The tools on the Tools tab are found the various
tools for cutting, copying and pasting selections.
This tab also includes the Distortion tool.

Modify tools

Tool What it means
| Align Left: Moves all selected objects except
=3 the left-most item selected.

E,l Align Right: Moves all selected objects
except the right-most item selected.

Align Top: Moves all selected objects except
the top-most item selected.

E] Align Bottom: Moves all selected objects
except the bottom-most item selected.

Horizontal Center: Takes all selected
objects and centers them in the selection
box. Objects will be moved so that they are
centered left-to-right with each other, but they
are not moved up or down.

=

Misc.

Tool What it means

- Distortion: Displays the Distortion window
which adds interesting effects to the selected
design.

View Tab

The Windows and Show/Hide checkboxes are
found on this tab. These controls allow you to
change what appears on your workspace; which
panels are displayed, whether or not commands
and stitch points are shown in the design, and so
on.

Windows

In the windows area, check the box to show the
corresponding window or panel, and uncheck it
to hide that window or panel.
+  Sequence. Shows/hides the Design
Sequence view.
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+ Palette. Shows/hides the Color Palette.

« Properties. Shows/hides the Properties
panel.
Simulator. Shows/hides the sewing
simulator.
Status. Shows/hides the status bar.
Navigator. Shows/hides the floating
Navigator panel.
Designs. Shows/hides the Designs panel.

Show/Hide

Check the boxes to show the corresponding
symbols in the Design Workspace.

« Entry/Exit. Shows the position of the first
and last points in the sewing of a
segment.

+ Commands. Displays icons in the
workspace that show where the color
changes and trims are.

- Stitch points. Shows the penetration
points of the stitches.

Preferences Tab

The preferences tab contains the tools for
opening the Preferences and Screen Calibration
dialogs.For more information, see “Setting up the
Workspace Environment” and “Calibrating the
Screen.”

Tool What it means
= Preferences: Displays the Preferences dia-
(..; log box. Contains the Formats, Environment,
Grid and Babylock tabs.
14—b|

Screen Calibration: Opens the Screen Cali-|
bration tool.

Simulating Sewing

The Simulator makes it easy to see how your
design will sew out on-screen. You can use the
Simulator to eliminate potential sewing
problems.

If the sewing Simulator does not appear, you
can open it by checking the “Simulator” box on
the Preferences tab of the Ribbon.

The Simulator (scrollbar slider and the sewing
simulator) will appear at the bottom of the design
window. The Simulator controls which parts of
the design are drawn on the design window.

Scrollbar Slider

The length of the scrollbar slider represents all of
the stitches in the opened design. You can move
the scrollbar slider by dragging it to see a design
as it will look sewn to a particular point. The color
display within the scrollbar indicates the thread
color that will be sewn when the scrollbar slider
is positioned over it. Clicking on the arrows at the
ends of the scrollbar will advance or retrace the
design position by one stitch.

Sewing Simulator

The sewing simulator allows you to watch your
design draw on a stitch-by-stitch basis,
simulating the sewing action of your machine.
You can push various control buttons and slide
the speed control to vary the rate of sewing.



Using the Simulator

The following table explains how to use the
Simulator in more detail:

Tools What it does

Previous Stitch: Move backward in
the design by one stitch.

Scrollbar slider: Drag the scrollbar
slider to advance the design to a spe-
cific position. When the scrollbar
slider is positioned over a color, you
will see the specified thread color
being sewn in the design. The entire
length of the scrollbar slider repre-
sents the entire design.

Next Stitch: Move forward in the
design by one stitch.

4 Simulate Sewing (backward): Move
backward through the design.

Stop/Pause: Pause or stop the
design while drawing. When you play

Il or resume sewing your design, stitch-
ing will continue from the location of
the last stitch.

Simulate Sewing: Move forward
through the design.

J Speed: Slide the speed control to
vary the rate of sewing.

Color Palette

The thread colors for the design are shown in the
Color Palette. To show the Color Palette, check
the Palette box on the Preferences tab of the
Ribbon.

For more information on the color palette, see
“Changing Thread Colors.”

Design Sequence

Design Sequence allows you to view information
that takes the form of branches. For instance,
each color in your design will have different lines
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of stitch information in that color. You can also
select outlines and stitches in the Design
Sequence by clicking on them. This becomes
important when you want to view or adjust an
individual part of your design.

To show the Design Sequence, select the
Preferences tab and check the “Sequence”
check box.

The Design Sequence control allows you to
expand and contract branches (colors) allowing
you to see or hide the individual outline
segments inside them.

Opening branches in a Design Sequence is a bit
like pulling open a file drawer; when it's open you
can see what'’s inside, but when it’s closed you
can't, although this takes up less space on your
screen. You open and close the branches of the
tree control by clicking on the + and - signs in
front of the branch name. For more information
on Design Sequence, see “Sequencing Outline
Segments”.

Design Sequence X

All items

e ;\1‘;}‘}-; 1. Madeira Thread Chest 1243 Deep Arctic Sky
| = A LWL Texdt
=] Madeira Thread Chest 1243 Deep Arctic Sky

=3 Madeira Thread Chest 1250 Emerald Green

] 5@ 4, Madeira Thread Chest 1257 Dark Maple

H ;—,\ 6. Madeira Thread Chest 1379 Qrange Red

<4 e ]

Properties | Design Sequence Color Palette Designs
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Status Line

The Status Line appears at the bottom of the
FontWorks window. To show or hide the Status
Line, select the Preferences tab, and check the
Status box.

As you move the mouse over different sections
of the workspace, this indicator will tell you what
that area does. You will also find specific design
information in other areas of the status bar. For
example, the status bar shows the total
segments in the design, the number of selected
segments and the number of stitches in the
selected segments.The Status line aiso shows
the size of the current hoop.

Total Segs: 20, Selected: 7. Stitches: 3062 Hoop: 3.94inX 3.94in

The Properties Panel

The design properties of selected segments are
shown in the Properties box. The Properties box
is located at the right edge of the design window
and contains tabs related to selected segments.

To show the Properties panel, open the
Preferences tab from the Ribbon, and ensure
that the Properties box is checked.

Properties x
Text] TextExtra Fill Underlay Pull comp. 4 b
MY TEXT
Font:
o Creampulff
: - ! Style: l.Default v
Height (mm): Spacing: =S
17.0 0 Align: | Center ey
Linespacing %:  Width (%)  Slant 0

25 1000 ABCE : Apply _|

Adjusting the Workspace
Splitter

The design workspace is separated from the
Design Sequence and Properties panel by a
“splitter”, which is the right edge of the design
window. To move a splitter, hover the mouse
over it exactly as you would a window edge, and
then drag it where you want. You'll notice that
when you're over a splitter, the cursor will
change to a double-sided arrow.

Sequence View
. Stitches

= g
e

=
1€

It is possible to reduce a splitter to the point
where nothing from the second window is visible.
If you have done this, just drag the splitter, being
careful that you're not dragging the outside
window edge.

Adjusting the Position of
the Panels

By default, the Design Sequence, Properties,
Color Palette, and Designs panels will be
“docked” on the right side of the workspace.
However, you can rearrange these workspace
panels into different positions. You can “float”
them above the workspace, in which case they
can be moved anywhere on your desktop; you
can hide them when they are not needed; or you
can undock them from their current positions and
dock them elsewhere.

You can also combine panels together by
“tabbing” them; you do this by floating a panel in
front of another panel and then docking it to that

panel with the tab |:.] button.



To float a docked panel:

1

Right-click on the panel’s title bar.
You will see a menu of options.

k Eloating
V' | Docking
Hide

Select Floating from this menu.

The panel now floats above the workspace,
you can drag and place it anywhere on your
screen.

To re-dock the panel to the same location it
was originally, right-click the title bar again and
select “Docking” from the menu; the panel will

| immediately go back to the former location. To
dock it elsewhere, follow the steps under “To
dock a floating panel”.

To hide a panel:

1

To

Right-click on the panel’s title bar.

You will see a menu of options.

Select Hide from this menu.

The panel will no longer be visible.

To show the panel again, go to the
Preferences tab, and in the Windows area
check that panel’s check box.

dock a floating panel:

Left-click the panel’s title bar and drag it a
short distance, continuing to hold down the
mouse button.

You will see a set of arrow buttons displayed
in the workspace. Five of them (four arrows
plus the tab button) form a cross shape, like
this:

|
i [
There will also be four isolated arrow buttons

like this pointing at the four sides of the
main window.

Properties
iCircle,) TextExtra Fil Underay M y
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2 Do one of the following:

+ To dock to the sides of a frame, drag the
cursor over one of the arrow buttons in
the cross.

A shaded area will appear, previewing the
position that the floating panel will dock. In
the instance shown below, the Color
Palette panel is being docked to the right of
the Properties Panel.

Upper.
Lower:
Font

Newspaper

Color Palette

|MadenaThread Chest v @

1243 Deep Arctic Sky

¢ To dock to the top, bottom, left or right
sides of the overall workspace window,
drag the cursor over the corresponding
isolated arrow button.

+ To make the selected panel into a tab of
another panel, move the cursor over the

tab [‘:] button in center of the “cross”.

Release the mouse button.

The floating panel will now be docked to the
selected location, and tabs labelled
“Properties” and “Design Sequence” will
appear along the bottom edge of the panel.
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Changing Thread
Colors

In FontWorks, you can adjust the colors of a
design using the Color Palette.

To change thread colors:
1 Select a segment.
2 In the Color Palette panel do one of the
following:
¢ From the drop-down list, select a Thread
Chart and click one of the color boxes
with the thread color you want to use.
+ Using the current list, click one of the
color boxes with the thread color you
want to use.

+ Click the Find Color |l_] button to search
for a specific thread. You can search by
thread color name or by color number (if
available).

3 Click on a color in the thread chart to select it.

The selected segment will change to the new
color; also, the new color will appear as the
current thread color in the swatch to the right
of the thread chart selection field.

Using Scrollbars

The scrollbars are inside the design workspace
on the right and bottom of the window. These
work just like the familiar scrollbars that you may
have encountered in any typical Windows
application; they appear whenever the design is
larger than the design window. They allow you to
quickly navigate the design using the mouse.

Typical actions for the scrollbars include:

- Dragging the Thumb Track u| to pan the
view. Notice that this is like using the Pan

& tool on the Edit Bar.

Clicking in the scrollbar on either side of the

Thumb Track | will move the design

window view one screen at a time.

N &

Clicking in the scrollbar on the arrows moves
the design window view only a small amount
at a time.

.t; |

You can also right-click the scrollbar to display a
pop-up menu of scroll actions in Windows.

Correcting Mistakes

Undo and Redo are two significant features that
allow you to correct mistakes. If you make a
mistake and change your mind about an action
you just made, Undo reverses the action. Redo
puts back the change.

If Undo or Redo are grayed out, you cannot
Undo or Redo.

To use Undo:
* Do one of the following:
+ On the Quick Access tool bar, click the
Undo [£7 tool.
* Press Ctrl+Z on your keyboard.

To use Redo:
¢ Do one of the following:
¢ On the Quick Access tool bar, click the

Redo {34 tool.

+ Press Ctri+Y on your keyboard.



Setting up the Work-
space Environment

You can set up your design workspace
environment for all opened design files. You can
predetermine the units of measurement you want
to use for your designs, as well as decide how
often open design files get saved.

The following paragraphs describe the different
units of measurement that can be used in
FontWorks.

Metric

The dimensions in FontWorks can be displayed
in metric values. If you set your design
preferences to metric, it will remember it each
time you run FontWorks.

English vs. Metric

If you think in inches, you can set FontWorks to
measure everything in inches. To make the
change, open the Preferences dialog and click
on the Environment tab, where you can select
English from the Units list.

To set up your workspace environment:
1 Onthe Preferences tab, click the Preferences

dialog 4°F tool.
You see the Preferences dialog box.
2 Click the Environment tab.
3 From the Units list, select the units of
measurement you want used for your
designs: Metric or English.

You can also select the units of measurement
using the menu options available in your
design workspace. Right-click on the ruler at
the left or top of the window and select Metric
or English.
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4 From the Autosave list, select how often you
want FontWorks to save your designs.

Autosave is a function that periodically saves

, the open design or designs to disk, so that you

(5 will not lose all your edits in case of a service

interruption. For more information, see
“Restoring Autosaved Design Files”.

5 The "Show *.blf warning” box will be checked
by default. When checked, FontWorks will
display a notification if you close a design
that has not been saved in *.blf format.

6 The “Show warning for large satins” box will
be checked by default; this means that a
warning message will appear whenever the
design contains a Satin segment wider than
the maximum recommended stitch length (10
mm). You may choose not to have this
message appear by un-checking the box.

7 The Show Navigator at start-up box will be
checked by default; this means that the
Navigator panel will open every time that
FontWorks starts. Uncheck the box to not
display the Navigator at start-up.

8 Click OK.

Creating New Designs

When you open FontWorks, you can immediately
begin creating a new, untitled, design. The
design window automatically opens using the
default normal recipe (style), machine format
settings, and design information set in the
Preferences dialog.

To create a new design:
1 On the Quick Access tool bar, click the New/

Recipe tool.
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To open an existing design:

Alternatively, you may select the New tool. 1 On the Quick Access toolbar, click the Open
®  This will bypass the recipe dialog and a new Design tool.
,-L design window will open using the default
settings; these settings are located in the You see the Open Design dialog box.
Preferences dialog. 2 Inthe Look in list, browse to the location of

the file you want to open.
3 Inthe Files of type list, select a design file
type for the design you want to open.

(e - ) 4 In the File name box, enter the file name, or

You see the New Page dialog.

pora ) e e S L select the file you want to open by clicking
| Machns oma: 1y0s om0 1 bt oo o s, vt e the file. To open multiple files, press Ctrl on
PES - 2 R i .
.- & . your keyboard while selecting the files you
[T | Corcel . )
== — want to open. To open all files, select any file
and press Ctrl+A on your keyboard.
2 In the Recipe list, select the recipe you want 5 Select Preview to view a thumbnail (a small
to use for your design. representation) of the design.

The recipe you select will be applied to this 6, [ElickiOpan:

design only, and will not change the default I
settings in the Preferences dialog. To close a design:
g To change the default setting, open the ¢ Do one of the following:

Preferences dialog and select the Formats tab. o Click the small “x" on the file name tab at

L=

. : ) the top of the design window.
3 Inthe Machine format list, select the machine

format that you want applied to the design Designl Design2
when created. =~ .10 T [} 100 %0
4 Click OK. BB . e IR

You see a new design window. + Click the Accelerator button, and select

Close from the Menu.

Opening and Closing

Desi Tips:

eSIgns = To open a file you have recently worked on,
In FontWorks, you can open designs in a wide click the Accelerator button and then choose
variety of file formats such as the Baby Lock file the design file from the recent file list.
(*.BLF), etc. «  To limit the number of displayed designs in
When you open a Baby Lock file (*.BLF), the the Open Design dialog, you can enter the
default file type, into the design window, your first letter of the design name, followed by an
single design file contains both outlines and asterisk (*) and the file extension. For
stitches. When you open other files into the example, if you have an Embroidery design
design window, your design files open as file named Cats, enter C*.blf in the File Name
stitches. box and press ENTER on your keyboard. You

see a list of all the designs starting with C.
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Opening Files from the =

i |
Browser % (b l

|

The Browser is a very convenient way to search e TR o S L '

for and open files. It allows you to search
through and open design files from multiple o y “V
. . . . 0 ke r

directories simultaneously. So, if you have 2 iy e v ssrme s oyone o
Bz 20k . okratia e Se9IE 4

design files stored on a number of different

media - for example, a USB device, or CD, as | e o |
well as on your hard drive - it is possible to look
in all of these places at once, with the Browser
feature.

44— ZesignrlGls D6 hemr Midecert S Auma Lenes EUFLFAFIS EOF

3 Do one of the following:

+ To select a single design, click on the

. L thumbnail image.
The Browser displays a preview image of the + To select a number of separate designs,

design in its preview pane, as well as the click on each individually while holding
design’s name, overall dimensions, stitch count, down Ctrl.

and the number of colors that it uses. + To select a series of designs, click the

The design size that appears in the Browser first thumbnail, then shift + click on the
window depends on the Environment settings final thumbnail in the range.
#  inthe Preferences dialog. The selected files are highlighted.
/‘ ' To switch between English and metric or vice
versa, open the Preferences dialog and e E i

choose the Environment tab. . : . I i_ |

To open files using the Browser: == = e

-\

L e B4 VAR Y RLE e
. L WESK WESIC 4

1 Click the Accelerator 3 button, and select

the Browser \“/ tool. '

You see the Browser window.

2 Click in the check boxes next to the L e Iy — o2
directories you want to browse for designs; to
look in multiple locations, simply check more 4 Do one of the following:
boxes. ¢ Click Open.

The selected design or designs open in your
workspace; if multiple designs were opened,
each will open in its own fab.

If you check the box next to a folder which has
sub-directories, all designs in those sub-
directories will be display as well as those in

the main directory. ¢ Click Merge.
The selected design or designs will be merged
The preview pane shows a thumbnail image of with the current design.

each design present in the directory or
directories you have selected.
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Saving Designs

You can use Save or Save As to save designs in
a variety of file formats.

The Save As command lets you save an
alternative version of the design with a different
name, location, or file format. Save As is handy
when you want to keep your original design and
create another design with slight modifications.
The Save command saves the changes you
make to the current design.

%  For more information on the general rules of
editing segments, see "Editing Segments".

To save a design:
1 Click the Accelerator ‘j button, and choose

Save As... from the menu.

You see the Save As dialog box.

2 In the Save in list, browse to the location you
want to save your file.

3 In the File Name box, enter the file name for
the design you want to be saved.

4 In the Save As type list, select the file type
you want the design to be saved as.

5 To save the Applique along with the file,
check the “Export Applique” box.
For more information, see “Exporting
Applique Designs”.

6 Click Save.

To save changes to the current design:
e On the Quick Access toolbar, click the Save

Eﬂ button.

Working with External
Card Storage Devices

Reading Designs from
CardWorks Il

When you purchase and install CardWorks I,
you will be able to read designs directly from
your box.

For additional information on how to use
Cardworks Il, please refer to the CardWorks Il
instruction manual.

To read designs:
* C(Click the Accelerator @ button, and select
Read from CardWorks Il.

If you have not purchased and installed
¢ CardWorks Il, the Read from CardWorks Il
s option will be disabled (grayed out) on the
Accelerator menu.

Sending Designs to
CardWorks li

When you purchase and install CardWorks II,
you will be able to send designs directly to your
box. Note that you can send just one design at a
time to CardWorks II.

For additional information on how to use
Cardworks I, please refer to the CardWorks Il
instruction manual.

To send designs:
1 Open the design that you want to send.

2 Click the Accelerator ‘j button, and select
Send to CardWorks II.

If you have not purchased and installed

CardWorks Il, the Send to CardWorks Il

fd option will be disabled (grayed out) on the
Accelerator menu.



Reading Designs from
Amazing Box MAX

When you purchase and install Amazing Box MAX,
FontWorks allows you to read designs directly from
your box.

For additional information on using Amazing Box
MAX, please refer to the Amazing Box MAX
instruction manual.

To read designs:

» Click the Accelerator ﬂ button, and select
Read from AB Max from the list.
If you have not purchased and installed
P Amazing Box MAX, the Read from AB Max

. option will be disabled (grayed out) on the
Accelerator menu.

Sending Designs to
Amazing Box MAX

When you purchase and install Amazing Box MAX,
FontWorks allows you to send designs directly to
your box. Note that you can send just one design at
a time to the Amazing Box MAX.

To send designs:
1 Open the design that you want to send.

2 Click the Accelerator “; button and select
Send to AB Max.

If you have not purchased and installed

Amazing Box MAX, the Send to AB Max

/- option will be disabled (grayed out) on the
Accelerator menu.

Reading Designs from Little
MAX
When you purchase and install Little MAX,

FontWorks allows you to read designs directly from
your box. For additional information on using Little

FONTWORKS
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MAX, please refer to the instruction manual that you
received with your Little MAX.

To read designs:

+ Click the Accelerator Q button, and select
Read from Little Max.

If you have not purchased and installed Little
» MAX, the Read from Little Max option will be
- disabled (grayed out) on the Accelerator
menu.

Sending Designs to Little
MAX

When you purchase and install Little MAX,
FontWorks allows you to send designs directly to
your box. Note that you can send just one design
at a time to the Little MAX.

For additional information on using Little MAX,
please refer to the instruction manual that you
received with your Little MAX.

To send designs:
1 Open the design that you want to send.

2 Click the Accelerator Q button and select
Send to Little Max.

If you have not purchased and installed Little
MAX, the Send to Little Max option will be
disabled (grayed out) on the Accelerator menu

¥

Reading Designs from
Embroidery Assistant

When you purchase and install Embroidery
Assistant, FontWorks allows you to read designs
directly from your box. For additional information
on using Embroidery Assistant, please refer to
the instruction manual.

29



30

CHAPTER 2
Learning the Basics

To read designs:

¢ Click the Accelerator ‘j button, and Select
Read from Emb Assistant

If you have not purchased and installed

Embroidery Assistant, the Read from Emb

/a Assistant option will be disabled (grayed out)
on the Accelerator menu.

e

Sending Designs to
Embroidery Assistant

When you purchase and install Embroidery
Assistant, FontWorks allows you to send designs
directly to your box.

For additional information on using Embroidery
Assistant, please refer to the instruction manual.

To send designs:
1 Open the design that you want to send.

2 Click the Accelerator 9 button and select
Send to Emb Assistant.

If you have not purchased and installed
> Embroidery Assistant, Send to Emb Assistant
. will be disabled (grayed out) on the
Accelerator menu.

Working with Recipes

Selecting Recipes

You can apply predefined settings when you
open a new file. For example, the Cap recipe
contains special underlay, pull-compensation,
and density settings appropriate for designs that
will be sewn on baseball caps. See "Preinstalled
Recipes" for more information on the preinstalled
recipes available and their settings.

To use a recipe:
1 On the Quick Access toolbar, select New/

Recipe

You see the New Page dialog.
2 From the Recipe list, select a recipe.
The new recipe change is for this design only.
3 From the Machine Format list, select the
machine format you want to use for your
document.
4 Click OK.
You see the recipe you selected appear in the
title bar.

Changing Machine
Format Properties

All designs in FontWorks have a machine format.
Machine formats have their own profile settings
that determine how embroidery information will
be interpreted when you save design files. When
you use machine formats, your design
information displays accurately on the screen.

When you create a new design file, you can
select the machine format for the specific design.
The selected machine format can change how
the design file is read. For more information, see
“Creating new designs”.

When you set machine format properties in the
Preferences dialog, all new designs will use
these machine format properties as the default
settings.

To change machine format properties:
1 Onthe Preferences tab, click the Preferences

tool.
You see the Preferences dialog box.
2 Click the Formats tab.



3 From the Recipe list, select the recipe you
want to use for your design.

4 From the Machine format list, select the
machine format that you want applied to new
design files.

5 Click OK.

Restoring Autosaved
Design Files

FontWorks makes it easy to restore the last
design file you worked on. You can restore a
saved design file as well as restore a copy of the
last design file you closed but did not save.

To restore unsaved designs:

+ Click the Accelerator 0 button, and choose

Restore last Autosaved from the list.
You see the restored design file appear in the
design workspace.

Printing Designs

Changing the Print Settings
You can customize print settings for your
embroidery designs. With FontWorks, you can
adjust the image and worksheet information
displayed in design printouts.

To change a design’s print settings:

1 On the Quick Access Toolbar, click the Print
Preview @ tool.
You see the print preview window appear
displaying your design.

2 Click Settings.
You see the Print Settings dialog.

3 Inthe Margins area, enter the margin sizes
you want for your design worksheet.
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4 Select Print Actual Size to have your design
print in its actual size.

5 Select Print Color Analysis to print an
expanded thread design sequence that
includes a view of the colors used, the color
sequence, and the thread consumption for
each color.

6 Select Print In One Page to print the design
on a single worksheet page.

If Print Color Analysis is selected along with
Print In One Page, your print out will display a
basic thread design sequence that includes a
simplified view of the colors used, the color
sequence, and the thread consumption, along
the bottom of the page.

7 To prevent jump stitches from showing on
your print preview, check the Remove Jump
Stitches box.

8 Select Show Crosshair to print a crosshair
mark on the print preview.

9 Select Print Company Name to have the
name of your company logo printed on your
design worksheet. Enter the name or the
company in the box below.

10 Click OK.

Previewing a Design before
Printing

You can preview a worksheet on the screen
before sending it to the printer.

To preview a design:
1 On the Quick Access Toolbar, click the Print

Preview (_ tool.
2 To zoom in and out of the previewed

worksheet, do the following:

+ To zoom in on the worksheet, click Zoom
In and scroll to view specific parts of the
design.
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¢ To zoom out on the worksheet, click Zoom
Out and scroll to view specific parts of the
design.

To change the settings for the design

worksheet, click Settings.

Click OK.

To close print preview and return to the

design window, click Close.

Printing Design Worksheets

You can print worksheets for design files. When
you print a worksheet for a design file, the
worksheet information depends on the selected
settings in the Print Settings tab.

To print a worksheet for your design:

1

On the Quick Access Toolbar, click the Print
Preview (- tool.

You will see a preview of the design
worksheet.

To change the settings for the design
worksheet or check the information that will
be printed on the worksheet, click Settings.
You see the Print settings dialog; for more
information about changing the Print Settings,
see “Changing the Print Settings.”

3 Click OK to close the Print Settings dialog.
4 On the Print Preview page, click Print.
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Viewing & Measuring Designs

FontWorks gives you the methods you need to view your designs with
accuracy. You can view your entire design on-screen or pan to view only
parts of your design not visible in the design workspace.

In this chapter:

Using viewing tools, buttons, and commands.

Adjusting Grid Settings.

Inserting and removing guidelines to help align parts of the design.
Using the Ruler tool to measure objects.

Calibrating the monitor screen to ensure accurate measurements.
Selecting and displaying a hoop in the design window.

Creating a custom hoop.
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Viewing Methods and
Tools

Magnifying and reducing
the view

Use Zoom to magnify or enlarge parts of your
design. Reducing a design lets you see more of
your design on-screen. With Zoom you can
either left-click to enlarge your design or right-
click to make your design smaller.

- For more information on magnifying and
A enlarging parts of your design, see “Zoom and
Pan tools.”

To use Zoom:

1 On the Home tab, click the Zoom & tool.

The pointer becomes a magnifying glass.
2 Do one of the following steps:
+ Right-click to make your design smaller.

¢ Left-click that area to zoom-in on a
specific area.

To zoom-in on a specific area:

1 On the Home tab, click the Zoom Cg tool

The pointer becomes a magnifying glass.

2 Click and hold your left mouse button and
drag your mouse to form a flexible box
around the specific area you want to see in
detail.

3 Do one of the following steps:

+ To increase the zoom, continue clicking
and dragging the flexible box. By doing
s0, you can view a single stitch.

¢+ On the Home tab, use the Zoom tools to
zoom back out.

Other Zoom tools

Zoom In '9 to make the view of the design
larger by a fixed amount.

Zoom Out fo to make the view of the
design smaller by a fixed amount.

« To Fit @ to make the whole design fit the
size of the design window.

« To Selection: Zoom to selection zooms to
the size of the current selection, (or group of
embroidery segments, if more than one is
selected.)

You will find “To Selection” by clicking under
the Zoom Q%\' icon, which opens a fly-out

menu of the zoom tools.

1:1 “9 to see the design at the actual size.

Slider Tool @ . Drag to select the

degree of magnification of the design.

Pan Tool

The Pan @ tool turns your cursor into an icon

of a hand. This allows you to drag the window
around, while, at the same time, being able to
see where you are moving. This is similar to
moving around the window using the scrollbars.

The Pan tool does not move any design
objects, only the area of the overall design that
is being displayed.

¢ To use the Pan tool, select the Home tab and
click on the Pan icon.

If the Pan tool is selected, you can right-click and
the last-selected tool will be selected. This will
deselect the Pan tool.



Panning with the Arrow
Keys

You can move to parts of your design that go
beyond the window’s borders.

To pan up:
* Use the 1‘ key to move up.

To pan down:

* Usethe } key to move down.

To pan left:

e Use the 4= key to move left.

To pan right:
¢« Usethe = key to move right.

Navigator Window

The Navigator window is another tool you can
use to change the view of your design. It can be
used to Zoom in and out of the design, and also
to pan the design in the Workspace.

The Navigator window is a small window that
floats above your workspace. In the Navigator
window, you will see a smaller version of your
design, with a red rectangle superimposed upon
it. If you are zoomed in, so that not all of the
design is shown in the workspace, this rectangle
shows what part of the design is currently
displayed.
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Dragging the slider along the bottom of the
Navigator window increases or decreases the
size of the rectangle, which in turn changes the
degree of zoom in the design window. You can
also pan the view by clicking and dragging the
red frame in the Navigator window.

The Navigator window is on by default when
you start FontWorks. To stop it from opening
by default, uncheck the “Show navigator at
startup” box on the Environment tab of the
Preferences dialog.

You can also show/hide the Navigator using
the check box in the Windows area of the
Preferences tab.

R

Viewing Buttons

Changing the background
of the current window

Depending on the type of artwork you are using
or the design you are creating, you may want to
change the background color of your window.
For example, if you are creating a design with
light thread, you may want your background
darker so that the stitches are more visible on-
screen. Use the background color button located
at the top of the design window to change the
background color.
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You can also use the Background Color - Fabric
setting to simulate the color and pattern of the
fabric you will be sewing on.

To change the background color:
1 On the Home tab, click in the Background

Color |S> tool to open the fly-out menu.
You see a menu with two options: Select
Color or Select Fabric.
2 To change the background to a new color, do
the following:
+ Choose “Select Color” from the menu.
You see the Color dialog.
¢ In the Color dialog, do one of the
following:
+ Place your mouse pointer in the color
spectrum and click to choose a color.
+ Select a color from one of the preset
swatches in the Basic Colors area.
+ If you know the RGB values of the
desired color, type them in the Red,
Blue and Green boxes on the bottom-
left of the dialog.
+ In the Color dialog, click OK.
The new color replaces the old color on your
design window.
3 To change the background to a fabric image,
do the following:
¢ Choose “Select Fabric” from the menu.
You see the Open dialog.
+ Select one of the available fabrics or
browse to the location of the image file for
your own scanned fabrics.

Usually it is best to save your fabric image as a
JPEG file, as these take up less disk space
than other formats.

Try to keep your file small in pixel size —
300x200 is typical, and more than 640x480 is
going to give you a large image. If there is a
quality setting, use ‘Web’ or ‘Low’ quality. Don't
be afraid to experiment; if a scan is too big or
small or there is some other problem, adjust
the settings and try again.

You see a preview on the right of the dialog.
+ Click Open.

The image of the fabric replaces the old color
on your design window.

Showing and hiding
machine commands

FontWorks makes it easy to view the locations
on the design where the embroidery machine
performs commands. These locations are
marked with different symbols to display the
command type.

To show commands:

e On the Preferences tab, in the Show/Hide
area, check the Commands box.
The commands symbols will be displayed in
the design.

To hide commands again, uncheck the box.

Showing and hiding the
stitch points in designs

Turn on the Stitch Points to see the stitch
penetration points in the design window. The
black dots in your design represent the point
where the embroidery machine needle will
penetrate the fabric.



To show the stitch points:

» On the Preferences tab, check the Stitch
Points box.
The stitch points will be displayed in the
design.

To hide the stitch points again, uncheck the
Stitch Points box.

Showing and hiding 3D
stitches

e
Use the 3D ;_‘f tool to preview a realistic 3D
view of your design.

To show 3D stitches:

- On the Home tab, click the 3D i tool.

The design will appear in 3D view.

To turn off 3D view, simply click the 3D tool
again.

Working with the
Workspace Grid

Showing and hiding the
workspace Grid

You can show the grids or, if they are in the way,
you can hide them.

To show the grid:

+  On the Home tab, click the Grid [:}] tool.
The Grid will appear in the design window.

To hide the Grid, click the Grid tool again.
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Defining grid settings

The Grid helps you align and measure artwork
and design elements. You can set the grid to
measure in millimeters or inches according to
your preference. When you are working on a
design file, you can display the grid by clicking

the Grid tool [] (the Grid tool is found on the
Home tab).

By default, every 10 horizontal and vertical lines
will be highlighted as the major grid. You can
adjust this value as well as increase or decrease
the spacing values for the minor grid; however,
zero and negative spacing values are not
supported. The minor grid can also have different
horizontal and vertical spacing values.

To make grid lines more visible on particular
backgrounds, you can change the color of the
major and minor grids. You should choose
separate colors for each grid type.

To define grid settings:

1 Right-click on the rulers at the left or top of
the window and click Grid Settings.
You see the Grid Settings dialog.

You can also access the Grid settings by way
of the Preferences @ tool on the

Preferences tab.

I Giid
Spacing Grid Major
| Horizontal {mm): 0 Horizomally every (ines): 1
Vertical fmm): 10 Vestically every fines): 0
I |8
Style Oplions
Show grid as solid ines 7 Snap to grid
| 1@ Show grid as dashed hnes 7} Snap lo guidelines
+ Show grid as dols
| OK Cancel
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2 In the Spacing area, complete the following:

+ Inthe Horizontally every (lines) box, enter
the measurements for horizontal spacing
in millimeters or inches.

+ In the Vertically every (lines) box, enter
the measurements for vertical spacing in
millimeters or inches.

+ From the Color list, select a predefined
color to use for the minor grid. If you want
to choose from a larger selection of
colors, click More... in the color box.

3 In the Grid Major area, complete the
following:

+ |n the Horizontal lines box, enter how
often you want horizontal lines to be
highlighted in the major grid. For
example, if you enter 3 in the horizontal
lines box, every third horizontal line will
be highlighted in the major grid.

+ In the Vertical lines box, enter how often
you want vertical lines to be highlighted in
the major grid. For example, if you enter 5
in the vertical lines box, every fifth vertical
line will be highlighted in the major grid.

+ From the Color list, select a predefined
color to use for the major grid. If you want
to choose from a larger selection of
colors, click More... in the color box.

4 In the Style area, select one of the following
grid styles:

+ Show grid as solid lines.

+ Show grid as dashed lines.

¢ Show grid as dots.

5 In the Options area do either (or both) of the
following.

+ To force the artwork tools to snap to the
grid while entering points, check Snap to
grid.

+ To force the artwork tools to snap to the
guidelines while entering points, check
Snap to guidelines.

6 Click OK.

Using Guidelines

You can use guidelines to help you precisely
align text and designs in your embroidery
designs. Guidelines are straight horizontal or
vertical lines that you drag from the rulers into
your design. These guidelines are easy to make
and they are useful for setting alignment lines
across the length or width of the design
workspace.You can also move your vertical and
horizontal guidelines, once created.

Creating new guidelines

To create a horizontal guideline:

1 Position the pointer inside the ruler at the top
of the window.

2 Hold down the left mouse button and drag the
guideline into the design window.

3 Release the mouse when the guideline is in
the position you want.

To create a vertical guideline:

1 Position the pointer inside the ruler at the left
side of the window.

2 Hold down the left mouse button and drag the
guideline into the design window.

3 Release the mouse when the guideline is in
the position you want.

To move existing guidelines:

1 Position the pointer on the guideline you want
to move.
When the pointer is correctly positioned, you
will see a double-arrow symbol appear next to
it.

2 Hold down the left mouse button and drag the
guideline to a new position in the design
window.



3 Release the mouse button when you reach
the desired position for your guideline.
The guideline is placed.

Removing guidelines

If guidelines are cluttering your workspace, you
can remove them.

To remove all guidelines:

» Right-click on the rulers at the left or bottom
of the window and click Remove
Guidelines.

The guidelines are removed.

Viewing the sewing order

You can view the sewing order of designs by
using the Simulator tools located at the bottom of
the design workspace. The speed control
determines the speed at which the design is
drawn on the screen. You can slide the speed
control from left to right to vary the rate of
sewing.

To view the sewing order of a design and adjust
the drawing speed, use any of the following
sewing simulator settings from the Simulator:
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Tools What it does

Simulate Sewing (backward):
4 Move backward through the
design.

Pause/Stop: Pause or stop the
design while drawing. When you

]} play or resume sewing your design,
stitching will continue from the loca-
tion of the last stitch.

Simulate Sewing: Move forward
through the design.

Speed: Slide the speed control to

- vary the rate of sewing.

Tools What it does

_‘_I Previous Stitch: Move backward
in the design by one stitch.
Scrollbar slider: Drag the scroll-
bar slider to advance the design to
a specific position. When the scroll
bar slider is positioned over a color,
you will see the specified thread
color being sewn in the design. The
entire length of the scrollbar slider
represents the entire design.

Next Stitch: Move forward in the

= (| E—

design by one stitch.

Displaying a Hoop

Viewing the hoop or frame on the screen lets you
ensure that your design fits properly when you
run it on the machine. The hoop serves as a
quide to help size and position your design in the
design window.

FontWorks comes with many different pre-loaded
hoop sizes. Your hoop size determines how large
the design can be when it is saved.

Viewing the Embroidery
Hoop

The Hoop tool toggles the display of the

embroidery hoop on and off. The hoop size is set
by your settings under the Hoop dialog in
FontWorks.

Clicking the Hoop tool has no effect on the
current mode, but will affect your current zoom. If
the hoop is off and you turn it on, the display will
zoom to fit the hoop into the window. If the hoop
is on, and you turn it off, you will be zoomed to
fit.
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Changing Hoop Settings
You can select one of many pre-loaded hoops
using the Hoop dialog. You will notice that you
can select hoops from different file types in this
dialog. This is useful when you want to make
sure that your design will fit for more than one
kind of embroidery machine.
The hoop that you select will be the limit to the
size of the design for saving purposes. When
' you save a design that is too big for the hoop

- you have chosen, you will get an error
message.

1 On the Home tab, click under the Hoop |}

icon to open the fly-out menu.
You see the Hoops dialog.

[EEN
Hoops - E
| [PES v_|[:]MultiNeedle
Select hoop
["160mn X 260mm o] [ New..
200mn X 200mm
130mm X 180mn i
150mm X 150mn Delsle
100mm X 180mm |
[ 100mm X 100we |
130mm X 60mn |E
90mn X 80mm
130mm X S0mn
60mm X 40mm
60mm X 20mn =
|
[JRotate 30 1060.0X1000mm |
| [ ok | [ Cose Aoy | |

2 From the list, select the design file format for
the current design.

If you output designs in the PES format, you
will see that there is an option to select
“MultiNeedle” hoops. This applies only if you
have a MultiNeedle embroidery machine.

If you check this box, the list of hoop options
will change to a list of hoops that are used with
a MultiNeedle machine.

3 From the Select hoop area, select the hoop
you want to display in your design window
from the list.

4 To rotate the selected hoop 90°, select Rotate
90.

5 Click Apply.
The selected hoop will be displayed in the
design window.

6 Click OK.

To create a custom hoop:

1 On the Home tab, click under the Hoop @
icon to open the fly-out menu.
You see the Hoop menu.

2 From the Hoop menu, click on Select Hoop.
You see the Hoops dialog.

3 Click the New... button.
You see the New Hoop dialog.

New Hoop F = i_ ==
Width (mm): 100
| Height (mm}: 100
|
|| Name: My hoop
0K | | Cancal | ‘q
I = |

4 In the appropriate boxes, type in the desired
height, width, and name for the new hoop.

Note that, if the “custom” hoop you are creating
is a multi-needle hoop, you must add the
letters MN in front of the name (e.g. MN My

< hoop), in order for it to be saved to the multi-
needle hoops directory.
5 Click OK.

The New Hoop dialog closes, and the name of
the new hoop is displayed in the list in the
Hoops dialog box.

The newly created hoop must fit the embroidery
machine and the embroidery field cannot be
v larger than the machine specifications.



Using the Ruler tool

The design window ruler runs across the top
and left sides of the Design Window. It shows
you the coordinates of your mouse and the
placement of your text items.

Measuring designs

The Ruler

distance between any two points in your design
workspace. When you measure from one point to
another, the distance is displayed in the status
line located at the bottom of the window. The
status line shows the length of the ruler line, and
the height and width (vertical and horizontal
distance) relative to the start point of the
measurement; it also shows the angle from the
start point.

-, tool lets you measure the

% All measurements except the angle are
;& calculated in the unit of measure you set
using the Preferences dialog.

To measure designs:

1 On the Home tab, select the Ruler _, tool.
Your cursor changes to a ruler when in the
Design Workspace.

2 Click and drag your mouse until you are
finished measuring the item.

3 Let go of your mouse when you are finished
measuring.

4 Look in the status line at the bottom of your
screen for the measurement.

5 Right-click to stop the Ruler tool, or click on
the icon again on the Home tab.
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Changing the Ruler Origin
The ruler origin is the point where the horizontal
and vertical axes meet at zero on the rulers.
When you change the ruler setting, the new
setting becomes the default for any existing or
new design you open. Changing the origin is also
useful for realigning the grid to your design.

To change the ruler origin:

1 Move the pointer to the top left corner of the
rulers, where the rulers intersect.

2 Click the intersection, hold down the mouse
button and drag the ruler to the location you
want to place the origin.

As you drag, a large cross hair appears so
you can place the cross hair exactly where
you want it.

3 Let go of your mouse when the center of the
cross hair is where you want the origin (0
point) to be.

Setting ruler units

Large numbered rulers indicate the measure-
ment unit, such as inches or millimeters. The
small ticks indicate the increments of the units.
When you magnify or reduce the view, the incre-
ments of the unit measure adjust to reflect the
changes. In addition, if you change the grid set-
tings, the rulers change to fit the measurements
you set.

& The rulers change to fit the measurements
/% you set in the next window you open.

To set the ruler units:

e Right-click on the ruler at the left or top of the
window and select Metric or English from the
context menu that appears.

You see the ruler units change accordingly.
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Calibrating the screen for
accurate measurements

Screen calibration is a tool that allows you to
calibrate your monitor to display design
dimensions accurately. When you use the 1:1 tool
(from the Zoom drop-down), the design workspace'’s
ruler measurements will be accurate and match the
number of millimeters or inches that the design
measures.

To calibrate your screen:
1 On the Preferences tab click the Screen

Calibration... @ button.
You see the Screen Calibration dialog.

Screen Calibration.. ﬁ1
i
| Qc{@nrr's(}uﬂa;r
| FontWorks®
Bitmap dimensions
'| width (mimk B2 Height (male 2117 =
| .-F.léstl | I 0K _] | Cancel |

2 To calibrate the screen, place a ruler against
your monitor and measure the dimensions of
the image in the dialog.

3 Enter the dimensions you recorded in the
dialog on into the height and width boxes in
the dialog.

4 Click OK.

You can go back to the original screen
calibration by clicking the Reset button.
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Using the Lettering Tools

You can create beautiful lettering within your designs using the FontWorks
tools. Generate unique embroidery text in an array of shapes and sizes using
our powerful Text tool, as well as the vast selection of commercially available
TrueType® fonts.

FontWorks also allows you to merge lettering and add any stock design with
just a few clicks of your mouse.

In this chapter:
» Creating lettering using the Text, Circle, Monogram, Vertical, and Text to
Stairs tools.

+ Using Text on Path to create a text segment that follows a path, make
adjustments to the path’s shape, and save the new path shape.

+ Using the Font Importer tool.
+ Merging external stitch files into a design.
* Using the Font Art tool.
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Normal Text

Creating Normal Text
Single and multiple-line text items are created

using the Text A} tool. When first added to the

design workspace, they will appear with the
normal proportions for the font, but can be
adjusted.

To create normal text:

1 On the Home tab, select the Text AR tool.
2 Click once in the design window.

If another text item was already selected, your
A’ first click only de-selected that item. You'll have
to click again.

The default text “MY TEXT” appear in the
design window. You will need to make
changes to this text in the Properties box.
3 In the Properties box, click the Text tab.
4 In the text box, change the default text
accordingly.
5 Make any other changes in the Text
Properties box.
For more information on changing normal text
settings in the tabs, see “Normal Text
Properties”.
6 Click Apply.
Your text will change accordingly.

Tip: Avoiding Lettering with
Oversize Stitches

By default, lettering will be composed of satin
stitches. However, there is a practical limit to the
length of a single stitch; in FontWorks, that limit
is set at 10mm. Any re-sizing of a satin segment
that results in the stitch length going above this
limit will cause the following Warning dialog to be
displayed:

e -~
Warning H-h_ﬂ
| You have cteated satin segments whose width exceeds the
| ! _recommended maximum stitch length of 10mm. As a result,

you may experience difficuity when sewing this design on
your embroidery machine. It is advisable that you resize the
satin segments to achieve a width smaller than 10mm.

["] Do not show this warning again | oK |

e

If you see this warning message, it is strongly
recommended that you modify the text segment,
so that it does not have any stitches longer than
10 mm.

On the Fill tab of the Properties box, change the
fill to a standard fill type. For more information,
see “Adjusting Settings under the Fill Tab.”

Check the “Do not show this warning again”
box to stop this stitch length warning from
appearing every time you create a satin
column with a width greater than 10 mm.

To have the warning appear again after you
have disabled it, reset it on the Environment
tab of the Preferences dialog.

Adjusting a Text segment
with the Frame Handles

Text segments can be adjusted in two ways: by
way of a set of ‘handles’ that allow individual
adjustments to the text by dragging them with the
mouse, or by using the Properties box. (For
details on adjustment that can be made by way
of the Properties box, see Properties of Text
Segments—Changing Text Properties).

The adjustment handles for Text have many
functions; they can adjust the size, slant, width,
angle, and envelope (overall shape) of the text
segment. You can also select an individual letter
in a normal Text segment, and adjust its position
relative to the rest of the text, rotate it, or change
its size.



The following sections detail the ways that Text
items can be modified using the frame handles.
Adjusting the Size of Text

The size of text items can be adjusted using the
Proportional Sizing handle.

@

This handle i the black pennant pointing up on
the top-left of the text. If you drag this handle,
you will see the design scale proportionally,
which means that as you make the design wider,
the design also gets taller.

Adjusting the Width of Normal Text
ltems

The Width of text items can be adjusted using
the Width handle.

h

This handle is on the bottom-right of the design
and it appears as a black pennant pointing right.
If you drag this handle, you will be able to adjust
the width of the design, but you will not be able
to change the height.

If you want to adjust the height of a design, it
can be done in the Height (mm) box in the
Text tab. Enter the new size and click Apply.

’
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Adjusting the Corners of Normal
Text [tems

The corners of text items can be adjusted up or
down using the Corner handles.

The Corner handles are the black squares at the
corners of the design. They adjust the vertical
position of each corner.

Using the Envelope Handles

Normal Text items can be made to fit inside a
shape, called an envelope. To adjust this shape,
use the Envelope handles.

The Envelope handles are the round black
handles that are centered on the design, both
above and below the text. These handles can be
moved vertically to form a curved shape to the
text, top and bottom independently. Used in
combination with the Corner handles, a wide
variety of text effects can be achieved.
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Rotating Text

To rotate text, use the rotation handle. The
rotation handle is the blue circle at the top-right
of the design. Place your cursor over the rotation
handle and the cursor will change to a circle-
arrow handle.

Dragging this handle rotates the design to any
angle. You will see an outline of the design rotate
onscreen as you are dragging, and the text will
recalculate when you release the mouse.

Adjusting the Kerning (space
between letters)

The space between individual letters can be
adjusted using the kerning handles.

*

The kerning handles are the blue diamond
shaped handles that appear between each letter.
These handles move horizontally and can be

dragged to adjust the space between each letter.

If you move a kerning handle in the middle of

a word, you adjust only the space between

those two letters, thus if you add space, you

/& will see the entire text item expand, keeping
the distances you have between each of the
other letters.

-

Adjusting Individual Letters
in a normal Text Segment
Repositioning Individual Letters

Individual letters can be moved with the letter
handles.

The letter handles are the light orange squares
in the center of each letter. You can click on the
letter handle to activate individual letter size and
rotation handles, or you can drag the letter
handle to adjust the letter position left, right, up
or down.

Adjusting Individual Letter Sizes

Letters can be individually resized using the
letter size handles.

Letter size handles appear only when an
individual letter handle has been clicked on.
These handles are the green squares on the top-
left and bottom-right of the letter. Dragging them
increases or decreases the proportional size of
the individual letter.



Rotating Individual Letters

Individual letters can be rotated using the letter
rotation handles.

The letter rotation handles appear only when an
individual letter has been selected. These
handles are the green circles on the top-right
and bottom-left of the letter frame. Place your
cursor over the letter rotation handle and the

cursor will change to a circle-arrow handle O .
These handles can be dragged to rotate the

individual letter; similar to the way the rotation
handle will rotate a whole text item.

When the cursor is placed over the frame
handles, the cursor changes for the different

g functions.

Circular Text

Creating Circular Text

Use the Circle Text ﬁ tool to create text with a

circular shape. These will be created with normal
proportions for the font, and can be adjusted.

To create Circular text:

1 On the Home tab select the Circular Text ﬁ

tool.
2 Click once in the design window.

If another text item was already selected, your
first click only de-selected that item. You'll have
to click again.

I
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The default text, “MY TEXT” appears in the
design window. You can change this text in
the Properties box.

3 In the Properties box, click the Circle tab.

4 Inthe upper and lower text boxes, change the
default text accordingly.

5 Make any other changes in the Circle tab of
the Properties panel.
For more information on changing the
segment’s properties, see “Circle Text
Properties.”

6 Click Apply.
Your text will change accordingly.

Adjusting Circular Text

The Circular Text tool makes lettering in the
shape of circle. You can adjust the size, width
and spacing of the letters, as well as the size of
the circle. You can also rotate the letters around
on the circle, and easily encircle an embroidery
design.

#T”__ﬁ ._."k.&\" \:\ .»(r.,.*"\\
i . A0 &
&) L)

Circular Text is controlled in two ways: by
clicking and dragging on the handles of the text
frame with the mouse, or by using the Properties
box.

Once you have created a Circular text segment,
you enter the text you want in the Upper and
Lower text boxes on the Circle Text properties
page. For more information, see “Circle Text
Properties.”

Circle Text handles rotate with the text. All

terms, such as ‘top-center’ refer to the text in
its initial position without rotating.
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The adjustment handles for circle text can do
many things.

Adjusting the Size of Circular Text

The Sizing handle will adjust the height of
Circular Text letters.

This handle initially appears on the top of the
design and it appears as a black dot. If you drag
this handle, you will see the design scale
proportionally, which means that as you make
the design taller, the design also gets wider. As
you resize the design, however, the basic circle
that the text is on does not change.

Adjusting the Width of Text Around
a Circle

The width handle adjusts the width of the text.

This handle initially appears on the bottom, right
of the text as a black dot. If you drag this handle,
you will be able to adjust the width of the design,
but you will not be able to change the height.
This has the effect of filling around the circle
more (wider text) or less (narrower text).

Rotating Text Around the Circle

Text can be rotated around the circle using the
rotation handle.

The rotation handle is the blue disk at the
bottom-center of the lettering. Place your cursor
over the rotation handle and the cursor will
change to a circle-arrow handle.



Dragging this handle rotates the design to any
angle. You will see an outline of the design rotate
onscreen as you are dragging, and the text will
recalculate when you release the mouse. This
handle also controls the diameter of the circle
that the text is on. Moving the cursor closer to
the center of the circle creates a smaller
diameter, and moving the cursor away from the
center creates a larger diameter circle.

Adjusting the Kerning (space
between letters)

You can adjust the space between each letter in
the text with the kerning handlies. The kerning

handles are the blue squares between each let-
ter. These handles move horizontally and can be

dragged to adjust the space between each letter.

If you move a kerning handle in the middle of

a word, you adjust only the space between

those two letters, thus if you add space, you

/ will see the entire text item expand, keeping
the distances you have between each of the
other letters.

~y

Y N\
‘—;ﬁ_“. f )
(I'(.( ‘k Z 0 ; }‘
P "o Supan iy o

A\ V.

i 4 \ 1
& :1'1.-' o f":\
1\(\___"1_} "»' .5‘. I’
.: w-‘-..‘r:- a H

Adjusting Individual Letters
in a Circle Text segment
Moving a Letter

Individual letter positions can be adjusted using
the letter handles.
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The letter handles are light orange in color, and
appear in the center of each letter. You can click
on the letter handle to activate individual letter
size and rotation handles, or you can drag the
letter to adjust its position left, right, up or down.

Adjusting the Letter Size

Individual letter size can be adjusted with the
letter size handles.

Letter size handles appear only when an
individual letter handle has been clicked on. The
letter size handles are on the top-left and
bottom-right of the letter and are olive green.
These handles can be dragged to increase or
decrease the proportional size of letters.

Rotating Individual Letters

Individual letters can be rotated with the letter
rotation handles. These appear only when an
individual letter handle has been selected. The
letter rotation handles are on the top-right and
bottom-left of the letter and are green. Place
your cursor over the rotation handle and the

cursor will change to a circle-arrow handle o ;
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These handles can be dragged to rotate the
individual letter; similar to the way the Rotation
handle will rotate a whole text item.

Monograms

Creating Monograms
Monogram Text items are created with the Mono-

gram Text M (Monogram) tool. Monogram text

items use a different set of fonts, with Decora-
tions available for some of them.

To create monogram text:
1 On the Home tab, select the Monogram Text

W tool.

2 Click once in the design window.

If another text item was already selected, your
first click only de-selected that item. You must
click again to select the segment.

The default text “ABC” appears; this can be
changed using the Properties box.

3 In the Properties box, click the Monogram
tab.

4 In the Letters box, change the default text
accordingly.

5 Make any other changes in the Monogram
Properties box.
For more information on changing normal text
settings in the tabs, see "Monogram
Properties”.

6 Click Apply.

Adjusting Monogram Text

Monogram text creates traditional three letter
monograms. Depending on the font chosen, you
can also add decorations to the monogram.

Monogram Text is controlled in two ways: A set
of ‘handles’ that allow individual adjustments to
the text by dragging them with the mouse, and
using the Properties box.

The adjustment handles for Monogram text can
adjust the size and shape of the Monogram in
many different ways.

Adjusting the Size of a Monogram

You can adjust the size of a monogram with the
Sizing handle.

The sizing handle is on the top-left of the design
and it appears as a black pennant pointing up. If
you drag this handle, you will see the design
scale proportionally, which means that as you
make the design wider, the design also gets
taller.



Adjusting the Width of a Monogram

The monogram width can be adjusted using the
width handle.

This handle is the black pennant at the bottom-
right of the monogram. If you drag this handle,
you will be able to adjust the width of the design,
but you will not be able to change the height.
If you want to adjust the height of a monogram,
it can be done in the Height (mm) box in the

-
/% Monogram tab of the Properties panel; enter
the new size and click Apply.

Adjusting the Corners of the
Monogram

The corners of a monogram can be adjusted
vertically using the corner handles.

N

The corner handles are the black squares at
each corner of the design. They adjust the
vertical position of each corner.
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Adjusting the Shape of a
Monogram with Envelopes

Monograms can have their outer shapes
adjusted with the corner handles.

ou “p

Envelope handles are the round handles that are
centered on the design, both above and below
the text. These handles adjust vertically to form a
curved shape to the text, top and bottom
independently.

Rotating the Monogram

Monograms can be rotated using the rotation
handle. The rotation handle is at the top-right of
the design and appears as a blue circle. Place
your cursor over the rotation handle and the
cursor will change to a circle-arrow handle.

oy

A

Dragging this handle rotates the design to any
angle. You will see an outline of the design rotate
onscreen as you are dragging, and the text will
recalculate when you release the mouse.
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Adjusting Individual Letters
in a Monogram
Repositioning Individual Letters

Individual letters can be repositioned in a
monogram using the letter handles.

The letter handles are the light orange squares
that appear in the center of each letter. You can
click on the letter handle to activate individual
letter size and rotation handles, or you can drag
the letter to adjust its position left, right, up or
down.

Resizing Individual Letters

Individual letters can be resized in a monogram
using the letter size handles.

Letter size handles appear only when an individ-
ual letter has been selected. These are the green
squares on the top-left and bottom-right of the
letter. Drag them to change the relative size of
the selected letter.

Rotating Individual Letters

Letters in a monogram can be rotated using the
letter rotation handies. They appear only when
an individual letter has been selected. The letter
rotation handles are on the top-right and bottom-
left of the letter. Place your cursor over the
rotation handle and the cursor will change to a

circle-arrow handle O .

These handles can be dragged to rotate the
individual letter; similar to the way the rotation
handle will rotate a whole text segment.

Vertical Text

Creating Vertical Text
Vertical Text items are created using the Vertical

Text (Vertical) /' tool. Vertical text items are
those that are created vertically.

To create vertical text:

1 On the Home tab, select the Vertical Text A

tool.
2 Click once in the design window.

If another text item was already selected, your
first click only de-selected that item; you will
have to click again.

The default text, “MY TEXT” appears; you will
can change this text in the Properties box.
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3 In the Properties box, click the Vertical tab. This handle is the black pennant pointing up, at
4 In the text box, type in the desired text. the top-left of the text. When you drag this
5 Make any other changes in the Vertical Text handle, the design scales proportionally — that is,
Properties box. as the design gets taller, it also gets wider.
For more information on changing normal text
settings in the tabs, see “Vertical Text Adjusting the Width of Vertical Text
Properties”. ) . . )
) The width of text items can be adjusted using the
6 Click Apply.

. . width handle.
Your text will change accordingly.

Adjusting Vertical Text

Vertical Text can be adjusted in two ways: by
way of a set of ‘handles’ that allow individual
adjustments to the text by dragging them with the
mouse, or by using the Properties box. The
frame handles have a number of functions.

Adjusting the Size of Vertical Text

The size of text items can be adjusted using the
Proportional Sizing handle.

iy S

This handle is the black pennant pointing right on
: : ; the bottom-right of the design. As you drag this
: =" handle, it will adjust the width of the design,
: without changing the height.

If you want to adjust the height of a design, do
* itin the Properties box, or with the Proportional
/% size handle, then adjust the Width handle to
achieve the exact size you need.
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Rotating Vertical Text

To rotate vertical text, use the rotation handle.
The rotation handle is the blue circle at the top-
right of the design. Place your cursor over the
rotation handle and the cursor will change to a

circle-arrow handle O .

Dragging this handle rotates the design to any
angle. You will see an outline of the design rotate
onscreen as you are dragging, and the text will
recalculate when you release the mouse.

Adjusting the Kerning of Vertical
Text

The space between individual letters can be
adjusted using the kerning handles.

The kerning handles are the blue diamond
shaped handles that appear between each letter.
These handies move vertically and can be
dragged to adjust the space between each letter.

If you move a kerning handle in the middle of a
word, you adjust only the space between those
two letters, thus if you add space, you will see
the entire text item expand, keeping the
distances you have between each of the other
letters.

L
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Adjusting Individual Letters  Adjusting Individual Letter Sizes

in Vertical Text Letters can be individually resized using the

ver . letter size handles.
Repositioning Individual Letters
Moving individual letters can be accomplished
with the letter handles.

Letter size handles appear only when an
individual Letter handle has been clicked on. The

The letter handles are the light orange squares letter size handles are on the top-left and

that appear in the center of each letter. You can bottom-right of the letter and are olive green.
click on the letter handle to activate individual These handles can be dragged to increase or
letter size and rotation handles, or you can drag decrease the proportional size of the individual
the letter handle to adjust the letter position left, letter.

right, up or down.
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Rotating Individual Letters

Individual letters can be rotated using the letter
rotation handles.

The letter rotation handles appear only when an
individual Letter handle has been clicked on. The
letter rotation handles are on the top-right and
bottom-left of the letter and are olive green.
Place your cursor over the rotation handle and
the cursor will change to a circle-arrow handle

These handles can be dragged to rotate the

individual letter; similar to the way the Rotation
handle will rotate a whole text item.

Creating Text on a Path

The Text on Path tool creates lettering that
follows a set linear path. For example, you can
use the Text on a Path tool to create text that
bends to follow the curved edge of a garment.

FontWorks comes with a set of shapes already
installed for you to choose from; or, you can
create and save your own shape, using the Edit
base line command. See “Creating a Custom
Text on a Path Shape.”

To create text along a path:

1 Onthe Home tab, select the Text on Path A

tool.
2 Click once in the design window.
You see the Select a text path dialog.

Select 3 path
|
‘ y |
II
Cornar Bortom_eft Corat BotomRign Cores Topleft Coerer TepRigh
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Lire Up Swgle Tuargls Dovm Tnangh Up

3 Select one of the paths from the Select a text
path dialog.
The default text, “MY TEXT” appears in the
design window along the chosen path.

4 To change the path shape that is applied to

the text, perform the following steps:
+ Right-click on the text segment.

+ In the option menu that appears, choose
“Text Paths...”

You see the Select a text path window.



+ To select the path you want, left-click it.

The Select a text path box closes, and you
see that the new path has re-shaped your
text in the design window.
5 To modify the Text on Path segment, open the
properties panel.
6 In the input text box, change the default text.
7 Make any other changes on the Properties
panel.
For more information on changing text
settings in the tabs, see “Editing Text in the
Properties Box” and “Normal Text Properties”.
The properties of Text on a Path are the same
% as those for Normal Text, except that you

/% cannot have multiple lines in a Text on a Path
segment.

8 Click Apply.
Your text will change accordingly.

Creating a Custom Text on
Path Shape

In addition to the Text on a Path shapes already
installed with your FontWorks software, you can
create and save your own shape, using the Edit
base line command.

To create a custom path:

1 Select the Text on a Path tool and use it to
create a text segment.

2 With the Text on Path text still selected, right-
click and choose Edit base line from the
options menu.

The baseline shape appears along the bottom
of the text, showing the anchor points (blue
squares).
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3 Click and drag the anchor points and
direction lines to modify the shape of the
baseline.

4 Right-click to re-generate the Text on a Path.

5 To save your custom shape, right-click and
choose “Export line” from the options.

You see a Save as dialog.

6 Type in a name for the new Text Path and
click save.

The new path will now appear in the Select
paths dialog when you use the Text on Path
fool.

In the “Select a text path” dialog, system paths
will be shown in red, while user-created paths
are shown in blue.

Text to Stairs

Creating a ‘Text to Stairs’
segment

Text to Stairs items are created using the Text to

Stairs ’Lﬂc tool. In a Text to Stairs text item the

letters are arranged so that they go down an
angled path, as if they were on a staircase. By
default, the Text to Stairs path will descend at a
45-degree angle, but this angle can be adjusted
in the properties panel.

To create Text to Stairs:
1 On the Home tab, select the Text to Stairs

*fﬁ(‘- tool.
2 Click once in the design window.

If another text item was already selected, your
first click only de-selected that item. You'li
have to click again.

r

By default, “MY TEXT” appears in the design
window. You will need to make changes to this
text in the Properties box.
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3 Inthe Properties box, click the Stairs tab, and
type the desired text into the Text field.

4 Make any other changes in the Stairs

Properties box.

By default, the Text to Stairs item will descend
at a 45° angle. You can adjust the angle by
entering a different angle in the Line angle
field Properties box.

To make a text segment that ascends, rather
than descends, enter a negative sign in front
of the value in the Line angle field (0° will
make a horizontal line).

For more information on changing the
properties of these segments, see “Text to
Stairs Properties”.

5 Click Apply.
Your text will change accordingly.

Adjusting Text to Stairs
using the frame handles

Text to Stairs segments are controlled in two
ways: either by dragging a set of ‘handles’ with
the mouse to adjust the segments bounding box,
or by way of the Properties box. For more
information, see “Text to Stairs Properties.”

The adjustment handles on the Text to Stairs
frame can be used to adjust the slant of the
letters within the segment, and to rotate the
segment as a whole.

You can also use the mouse to select and
adjust individual letters within the Text to Stairs
®»  segment; this works in exactly the same way
;3 as it does in normal Text.
For more information, see Normal Text—
Adjusting Individual Letters in a Text segment.

Adjusting the Slant of the Lettering

The slant of letters in a Text to Stairs segment
can be adjusted using the slant handle; this is
the black diamond-shaped handle on the left side
of the text frame.

By clicking and dragging on this handle, you can
make all the letters in the selected segment slant
forward or backward, depending on which way
you drag the mouse.



Rotating a Text to Stairs segment

Use the rotation handle to rotate the selected
Text to Stairs segment. The rotation handle is the
blue circle at the top-right of the text frame. Hold
the cursor over the rotation handle and it will

change to a circle-arrow handle (.

Dragging this handle rotates the text to any
angle. As you are dragging, a preview of the text
in outline rotates in the Workspace window.
When you release the mouse, the text’s stitches
will be recalculated.

Applying Special
Characters

All four modes of text will allow you to type in the
text that you want to embroider; however, there
is some variation between modes as to what you
can type in. For instance, you cannot create a
multi-line monogram. Despite the differences,
the method of typing in special characters
remains the same. When using the text box, you
can type in any character on your keyboard, plus
you can type in characters by their ASCII num-
ber. An ASCII number is a four digits code which
represents a character that may not have a key
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to represent it; for example, ™ or ® are symbols
that exist in some fonts but are not type-able on
a standard US/English keyboard.

In order to type in an ASCII code for a special
character, you hold down the ‘Alt' key while
typing in the ASCII number. When you release
the ‘Alt’ key, the character will appear.

Due to Windows constraints, you must type
the numbers on the keyboards numeric
keypad for this to work.

Displaying a font’s list of
characters

There is a display on the Text tab that shows you
what characters you can type — simply click on
the '?’ button, located next to the font name. You
will see a display similar to the following:

— -y

Lettering : Bookworm

ABCDEFGHUKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrftuvwxyz
0123456789

"#8% () +,-. /=@

Recommended Heights:
Minimum height for satin outlines: 1,77 inches/45mm

Minimum height for run cutlines: 0.59 inches/15mm
Maximum height for run outlines: 1.77 inches/45mm

Minimum height for satin: 0.39 inches/10mm
Maximum height for satin: 1,38 inches/35mm

| oK

You can also place your cursor over the preview
image of fonts to view the characters you can
type as well as minimum and maximum height
recommendations.
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Properties
Text. TextEBtra Fill Underlay Pull comp. 4 b
M TEXT

Font: [TTF

Z)%a‘@m | © Bookworm -

- =i
Height (mm} |ABCDEFGHIJKLMNOPQRSTUVWXYZ
20,0 abcdefghijklmnopgrstuvwxyz
' 0123456789

Linespacing® ' " #S% 0" -, -./

;=1®
25 Recommended Heights
Minimum height for satin outlines: 1.77 inches/45mm

Minimum height for run outlines: 0.59 inches/15mm
Maximum height for run outlines: 1.77 inches/45mm

Minimum height for satin: 0.39 inches/10mm
Maximum height for satin: 1.38 inches/35mm

Word Drops

Word Drops allows you to create a template. In a
template, a word segment can be replaced in the
same location many times. An example would be
to create T-shirts for each player on a sports
team. Instead of creating a separate design for
each T-shirt, use Word Drops to create each shirt
using the same logo design, but with a different
name.

Each design that will be generated by the tool
will have its own row in the dialog, displaying the
text, the font, the font height, and the alignment
of the lettering. Add a new row for each separate
embroidery design you need.

To use the Word Drops Tool:
1 Create the design you want to use as a basis
for the Template; using one of the text tools,

include some “placeholder” text in the design.

' The Word Drops will only work with files that
contain only a single text segment.

2 Save the design.
. G280
On Home tab, click on the Word Drops A

icon.
You see the Word Drops dialog.

e s e o ot v s 0

4 In the Output directory box, browse to the
folder to use as he destination for the
generated files.

5 In the Base filename field, enter a name to
use as the basis for the designs generated by
the Word Drops tool. When the files are
generated, the file names they will be given
will consist of the Base name, plus a
sequential two-digit number - e.g. team
01.blf, team02.blf, team03.blf, etc.

6 From the radio buttons on the dialog select
the behavior of the Word Drop tool after
generating the new files.

+ Open all saved files: Each file will open
(in its own tab) in the workspace.

+ Open only first saved file: Only the first
of the files will open.

+ Just save the files: The files will be
generated and saved, but not opened.

7 To output the generated files in your choice of
stitch format, do the following:

+ Click the Save formats | .. | button.
The Formats dialog opens.



Formats

Select output formats

| [¥]Baby Lock (BLF)
El Baby Lock/Brother Multi Needle (PES v9)
{_Baby Lock/Brother/Bernina (PES v9)
{"]Baby Lock/Brother/Bernina (PES v8)
[ |paby Lock/Brother/Bernina (PES v7)

") Baby Lock/Brother/Bernina (PES v6)

Dﬂaby Lock/Brother/Bernina (PES)

ﬂElna/Janome/Kenmore (SEW)

Dlanomc/Elna VEF)

[viking (HUS)

Clpfart (pcs) i

oK || cancet |

+ Check the box (or boxes) next to the file
formats that you wish to generate.
If you choose more than one format, a
separate file will be generated for each
format.

¢ Click Okay.
The Formats dialog will close; the selected
format (or formats) will be listed in the
Word Drops dialog beside “Save formats.”

8 To add new rows to the Word Drop table, do
the following:

¢ Click the “Add Name” button = .

A new row will appear in the Word Drop table,

with the Text field already selected.

+ Type the next name in the field.

+ Repeat the above until all lines have been
added.

+ You can remove a row by clicking the

“Remove name” = button.

9 In the text column of the table, enter the text
needed for each design.

10 If needed, make any of the following
modifications to settings in the table by
double-clicking the appropriate cell:
¢+ Choose a new font for the text.

+ Change the height of each name
individually.

+ Change the Alignment in the Align cells
(left, right, center).
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' Alignment is not applicable to Circular Text
segments.

11 To see how these modifications affect the
design, select a column and click the
Preview button in the final column,

——
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12 Click Save to create the files.

The specified files will be generated, and saved to
your destination folder.

Depending on which setting you chose in step 6,
one or all of the files will open in your workspace.

Font Art

The Font Art “3 tool is a special type of text

tool, that generates a number of words and
places them into a shape. The text paths are
scattered randomly within the boundaries of the
envelope shape, which you select from the
dialog.

Use the dialog to set other parameters of the
design, such as the maximum number of text
paths that will be included, the font used, the
orientation of the text, etc.

You can see how the Font Art will look in the
Preview window before you actually place it in
your design. This allows you to adjust settings,
and re-generate the Font Art as often as required
to get the desired result.
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To use Font Art:

1

3

Use an existing design page or create a new
design page.
On the Home tab, click the Font Art @ tool

icon.
You see the Font Art dialog.

- -1
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In the Shape area, do the following:
¢ Select a stitch type from the “Shape Type”
drop-down list:

+ Run: The envelope shape will
generated as a simple run stitch.

+ Run Bean: The envelope shape will be
generated as a bean stitch (also
known as three-ply or triple stitch).

+ Satin: The envelope shape will be
created as a satin or zig zag column.

+ Enter the overall dimensions of Font Art
outline or envelope the “Width (mm)” and

“Height (mm)” fields. Click the up and

down-arrows next to these fields to fine-

tune the dimensions in 1 mm increments.

The “Maintain aspect ratio” box will be checked
by default; when checked, both height and
width will be scaled proportionally when you
adjust either dimension.

You can uncheck “Maintain aspect ratio” if you
want to change one dimension without
affecting the other.

+ Select a Font Art Shape (envelope) from
the “Shape” column.

The selected shape will appear in the Preview

pane.

In the “Words” column, select the font you

want to use from the drop-down list. To select

from your available TrueType® fonts, check

the “TTF” box.

If not using the default height for the selected

font, enter a value in the "Height (mm)” field.

appear in the drop-down list, since not all of
them are compatible with the Font Art feature.

' Note that not all of the FontWorks fonts will
»

To add words to the Font Art design, do the
following:
+ Type your text into the “Enter new word

here” field, and click the “Add Word” |+ |

button.

+ Repeat the above for each word or
phrase that you want to add.
The words you have added will appear in
the Words list.

+ If you need to remove a word after it has
added, select it and click the “Remove

Word” [ % | button. To remove all words in

the list, click the “Remove All Words” | % |

button.

In the “Art Settings” area, do the following:

+ In the “Max Paths:” field, enter maximum
number of words that you want to include
in the design.

¢+ The words in the finished design will have
colors randomly assigned to them. You
can limit the maximum number of colors
that will be used by entering the desired
value in the “Max colors” field (up to 15).

¢ Inthe Scale fields (Min Scale/Max Scale),
click and drag the sliders to set the text
segment height range generated.
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The minimum and maximum height are Previen
expressed as percentages, where 100%
equals the original font height as set in
the “Words” area, "Height (mm)” setting.
+ Select the orientation of the words within
the frame.
+ Any Angle: When this box is checked,
the words in the finished design will be
oriented at random angles.

1Y 30 View

+ Horizontal [—|: All text paths wili be
oriented along the horizontal.

¢+ Vertical |LI] All text paths will be
oriented up and down.

+ Diagonal | / | Text will be placed at a

45° angle. S T G,

You can also select any combination of Sometimes, if there are many paths in the

Horizontal, Vertical and/or Diagonal to create Font Art. the Generate command will take a

= a combination of orientations in the finished
few seconds to process; a progress bar

design. ]
located along the bottom of the Preview
8 Click the “Generate” button to see the Font window, will display the status of the stitch
Art in the Preview window. generation.

10 If required, adjust your Shape, Words, scale,

If you click the “G te” button again, th . .
you cll e g e and Art Settings, and re-generate until the

Font Art tool will create a new arrangement of

the words you have entered. You can re- desired effect is achieved.
, o generate the design as often as you like until 11 When ready to place the Font Art in the
the desired result is achieved. design, press the “OK” button.
9 (Optional): Check the “3D View” box (located The Font Art will appear in the workspace.
at the top of the Preview window) to see a You can make additional adjustments to your
realistic preview of the finished Font Art words after the Font Art is placed in the

design' workspace.
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CHAPTER 5

Properties of Text Segments

FontWorks provides an easy and efficient way to help you change the
properties of your text segments.

Note that these property changes apply to designs created within FontWorks
only; you may not change the properties of embroidery designs imported into
. FontWorks using the Browser or Merge design feature.

In this chapter:

+ Adjustments that can be made to properties of all the different kinds of
Text segments.

» Pull-Compensation settings

* Underlay settings

s The Text Styles — Default, Run, Trapunto, Appliqué, Spiral, and Default
with Run — and the properties that can be set for each
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Changing Text
Properties

You can right-click on any text, regardless of its
type, and an edit menu will appear. This menu
allows you to change several important text
properties, such as changing or resetting frames
and changing envelopes.

To change various text properties using the
Properties box, see “Editing Text in the
Properties.”

Changing Text Modes

The Text Mode can be changed for an existing
text item in FontWorks. You can change an
existing text item to Normal Frame, Vertical
Frame, Path Frame, Circle Frame, or Monogram
Frame. Right-click the text item and select the
text mode from the menu.

v | Normal Frame
Vertical Frame
Path Frame
Circle Frame

Monogram Frame

Envelope »

Create outline...

Reset Frame
75 Delete

Properties

Delete

Alt+Enter

Selecting Pre-Defined
Envelopes

The Envelope feature allows you to set the
Corner Handles and the Envelope Handles into
several pre-defined patterns. You can use the
envelope feature for normal and monogram text.
In the design window, right-click on the created
text and select Envelope from the menu.

Rectangle

Bridge Concave Top

Bridge Concave Bottom
Double Concave Bridges
Bridge Convex Top

Bridge Convex Bottom
Double Convex Bridges
Concave Top Convex Bottom
Convex Top Concave Bottom
Pennant Right

Pennant Left

Fish Left

Fish Right

Wave Up

Wave Down

Envelope options

Create Outlines

With the “Create outlines” tool, you can add run
or satin border surrounding the selected text.
You can vary the distance between the text and
the outline by adjusting the offset value in the
Create Outlines dialog.

To create an Outline:
1 Select the text using one of the text tools.



2 Right-click and select Create outline from the
menu.
You see the Create QOutline dialog.

=
Create outline

|

Style Settings
6 Aun Offset (mm); 30
1 Salin Unite outlines

[ ok || cancel |

e d

3 Inthe Style section, select either Run or Satin
to determine the style of the outline stitches

4 In the offset field, enter the distance desired
between the original text and the outline.

5 On the Create outline dialog, you will see that
“Unite outlines” is checked by default; this
means that the outlines around each letter
will be combined into a single, continuous
shape. You can uncheck this box to create
satin or run outlines around each letter
individually.

Outlines

Above, a text segment with individual outlines around
the letters; below, the same segment with the out-
lines united.

Qutlines

6 Click OK.
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Text Direction

The Text Direction commands are only used to
change the location of text in Circle Mode.

Right-click the selected text and a context menu
will appear. If you select “Text Direction
Reverse”, the text in the Circle frame will switch
positions - the text in the upper part of the circle
will move to the bottom of the circle, and text in
the bottom will move to the top. To put the order
back the way it was, right-click and select “Text
Direction Normal” from the menu.

Resetting Individual Letters

The Reset Letter command is useful when you
have manipulated a letter and want to reset it so
that it looks as it would if it was never individually
adjusted. This command is available when you
activate individual letter size handles and right-
click the individual letter with your cursor.

Resetting the Frame

The Reset Frame command is useful when you
have altered your text a bit too much and want to
start over.

Deleting Text

The Delete command deletes the currently
selected Text Item.

Properties

The Properties command will show the
Properties box if it is not currently in view.
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Editing Text in the
Properties Box

The Properties box allows you to type in the
actual text for your design and change its
appearance, reflecting the type of text item that
is currently selected.

Properties X
Text. TextExtra Fill Underlay Pull comp. 4 b
MY TEXT
Font: [JTTE
o Creampuff v
- : Style: [W;
Height (mm}: Spacing: —————————
170 i Align: | Center |
Line spacing %:  Width %) Slant 0
2 1000 5] ———

The Properties box has tabs that allow you to
adjust specific settings. The first of the tabs will
be labeled, “Text,” “Circle,” “Monogram,” or
“Vertical” depending on the text item you have
selected. The other tabs are labelled “Text
Extra,” “Fill,” “Underlay” and Pull comp.”

The properties that can be set in the first tab
(that is, the “Text,” “Circle,” “Monogram,” or
“Vertical” tab) are described in their respective
sections, later in this chapter. The settings on the
“Text Extra” tab are described in the section “Text
Extra Settings.”

For more information about underlay, see

“Changing Underlay Properties”; for more

information about the “Pull-comp.” tab, see
“Adjusting Pull-compensation”.

The Text tab is used to enter the letters you want
to embroider. Most of these settings will be
familiar to users of word processing programs.

Letter Height

The Letter Height field is where you enter the
height desired for the lettering.

When you click the ‘?’ button, located next to the
font name, you can view a font’s minimum and
maximum height recommendations. They may
also be viewed by placing your cursor over the
preview image of fonts in the Text tab.

Selecting Fonts

Under the text box is an image showing a sample
of the font. The font is selectable from the drop-
down box below the font image. You can click on
the down-arrow to see a list of the fonts.

To scroll through the list of fonts and see what
they look like, click on the down-arrow, then
use the up and down arrows on your keyboard
to move through the font list. This allows you to

preview the fonts without having to select each
one.

You will notice that some fonts have a particular
size in their name, such as, “Block 4mm”. This is
because that particular font is designed stitch-
by-stitch for a particular size. You can change
the size of the font, but it is not recommended.
Stitches in these fonts do not recalculate, as with
the others.

Selecting TrueType® Fonts
(TTF)

You can also select the TTF option to view a list
of available TrueType® fonts. The list of fonts
shown in the Fonts drop-down list will change
accordingly.

»  Note that the Style property cannot be
applied to TTF fonts.



Spacing

The spacing control adds a specific amount of
space between each letter. Thus, if you wanted
to space your letters out, you can type a 2 in
here and click ‘Apply’. If the spacing is set to
zero, the default, then the normal kerning
operation for the font is used. You can use this
parameter to make the spaces between the
letters less than zero. You can also move the
letters closer together than the default, or
individually adjust the letter spacing, by adjusting
the letters with the kerning handles. For more
information, see the sections on “Normal Text”,
“Circle Text", “Monogram Text” or “Vertical Text”.

Width Percentage

The purpose of the Width % setting (sometimes
called “Width compensation”) is twofold: To
adjust the width of the text item for appearance,
or to compensate the text width so that you get a
greater accuracy in the final output size. The
Width Compensation adjustment is set in terms
of percentage, and automatically gets updated
as you drag the Width handle on the text item.

When compensating the text, a small percentage
adjustment is used to widen the text to make up
for normal shrinkage that happens to the fabric
during embroidery. If you are aligning the text to
other items, such as other text items, then this
compensation can be used to keep your
alignment sharp. If you are unsure whether or
not you might need some compensation, sew a
test sample.

FONTWORKS
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Slant

Use the Slant setting to create a slanted effect
for your lettering. Slant changes the degree
value of the slant on your lettering. A negative
value slants your lettering to the left; a positive
value slants it to the right.

Slant +
Slant -

Positive slant to the right and negative slant fo the left

Spelling Checker

The Spell Checker feature is accessed through
the Properties box in FontWorks. You can check
the spelling of text segments created by any of
the following tools: Text, Circle Text, Vertical
Text, or Text on a Path.

Note that Spell Checker uses the Microsoft
' Word spell check function, so it only works on
v computers that have Microsoft Word installed.

To use the Spell Checker feature:

1 Select one of the Text tools, click once in the
Workspace.

2 On the Properties panel, click the Spell

Checker “37| button to turn the Spell

Checker on.

3 In the text input box on the Properties page,
type in the desired text.
Any word that is misspelled will now show in
red; correct words remain black.
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Properties X
Text Text Extra Fill Underlay Pull comp. 4 b

Once upan atime....

4 To see a list of suggested correct spellings,
right-click in the text entry box next to the
incorrect word.

A list of alternatives appears below the text

entry box.
Properiies X
Circle! Text Extra  Fill  Underlay Pull comp. 4 b
Upper. l'Onceupnal'me =
an 1 —
Lower. [ n
on |
Font O no (;g é (-J
. j A
Stm Senpt v [ Ann ?/‘ )('

5 Click on the correct word that you want to
replace the incorrect one.
Your choice replaces the incorrect word.

6 Click Apply to create the text segment in your
workspace.

7 Click the Spell Checker button again to turn
off Spell Checker.

Normal Text Properties

Normal Text properties are adjustments specific
to normal text that can be made from the
Properties box. Remember, each version of text
(Normal, Circle, Monogram, Vertical, and Text on
Path) will alter the appearance of tabs from the
Properties box slightly.

The Text tab allows you to adjust a variety of
properties related to the selected text. These
include the text box, which is where you enter

the text that you want to embroider. This text box
is multi-line, so you can type in a whole phrase,
poem, etc.

> Normal text is the only text mode that aliows
_:‘ you to enter multi-line text.

i Properties
Text: TextExtra Fill Underlay Pull comp. 4 P
| |Designer's
| |Gallery
4l ) _ Font: CJTTF
AaBble | == -
Style: | Default
Herght (rm}): Spacing: —_
20.0 0 Align: ICenler vl
Line spacing % Width(x)  Slant 0
25 105.4

Aac ;ﬂﬂﬁ:ﬂlﬁﬂn!ullﬂ!l .
¥ [ Amy }

Line Spacing

The Line Spacing parameter is unique to the
Normal Text'mode. This allows you to set the
distance between lines of text based on a
percentage of the text height. The default is
25%, but, of course, you can adjust that up or
down to improve your results or to squeeze more
text into your hoop.

Alignment

The Align property is found only in the Normal
Text mode. The alignment is used for multi-line
text segments. The choices are Left, Center and
Right. For example, Left alignment means that
every line will start at the same left position.




Path Align

This is a setting that applies to Text on Path
segments only. With the Path Align setting, you
can determine how the letters will be oriented
relative to the base line - Above, Center, Below
and Reflect. Click Apply to apply the change.

Circle Text Properties

Circle Text properties are adjustments specific to
circle text that can be made from the Properties
box. Each style of text (Normal, Circle,
Monogram, Vertical, and Text on Path) will alter
the appearance of the Properties box slightly.

|
i Properties
|/Circle, TextExtra Fill Underlay Pull comp. 4 b
| Upper: IDesigner's
Lower. |I3a||ery

Font [CITTF |

0 SmoothBlock v |?|‘ A@Bf@@@ '

Ste: Defaut | @]

Height (mm}: 153 Spacing: 0
Widh(x; 1054 =
___bpsly |

The Circle tab allows you to set a variety of
options regarding your text. The most important
field is the text box, in which you can type in the
text that you want to embroider.

The direction that the letters run depends on
whether they are typed in the Upper or Lower
text boxes in the properties box. When you first
create a Circle text segment, the lettering is
placed in the Upper text box by default; it is
placed so that it runs along the top of the circle,
reading clockwise, like so:
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If you want to have the text appear on the bottom
of the circle, type it in the Lower text box; it will
then appear on the bottom of the circle, reading
counter-clockwise, thus:

An advantage of the Circle Text tool is that you
can also enter text in both the upper and lower
text boxes, to provide a ‘framing’ effect.

When done adjusting, click ‘Apply’. On some
adjustments, such as the spacing, you can hit
‘Enter’ on your keyboard, and the program
applies the changes.
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Monogram Properties

Settings that are specific to monograms can be
made from the Properties box.

Properties X
Monogram.| Text Extra Fill Underlay Pull comp. 4 b

Font: Diamond Monog +

Letters: ABC
Height (mm):  30.0
Spacing: 0

Width (%) 100.0

= u Decor: ‘@ :

Ty

LT

The Monogram tab allows you to set a wide
variety of options and decorations for your text.
The most important item is the Letters box, which
is where you can type in the text that you want to
monogram. Next to the Letters box, is a bitmap
showing a sample of the font.

The Diamond and Round monogram fonts can
be used to create one-, two-, or three-letter
monograms.
Other fonts only allow three-letter Monograms
to be generated. If you enter one or two letters
i into the text box in these fonts, the Monogram
tool will change the letters in the text box to
‘ABC'.
Note that the maximum number of letters in a
Monogram is three.

oy

When all required adjustments have been made,
click the ‘Apply’ button. On some adjustments,
such as the spacing, you can just hit ‘Enter’ on
your keyboard, and the program applies the
changes.

Decor options available

The Decor for the monograms is font-specific:
only the Diamond Monogram and Round
Monogram fonts contain decorations. Simply
click the down-arrow on the Decor drop-down
box and scroll through the samples of
decorations. When you find the one you want,
simply click on it.

Vertical Text Properties

Vertical Text properties are adjustments specific
to Vertical Text that can be made from the
Properties box. Note that the settings contained
in the Properties box will be slightly different,
depending on with type of text (Normal, Circle,
Monogram, Vertical, and Text on Path) is
currently selected.

I:\_-\ﬁa_rtm Text Extra Fill Underlay Pull comp. q4 b
i ]Designer's
Font: OTTF : o |
'
— 2 =Y
Slant Script ~ (2] A@LE@Q;@:
Style: | Default
Height (mrn): 20.0 Align: | Center v i
Line spacing %: 25 Slant: 0
Width (%) 105.4 —
o | Apply |

The Vertical tab allows you to set a variety of
options regarding your text. The most important
item is the text box, which is where you can type
in the text that you want to embroider. Below the
text box, is a bitmap showing a sample of the
font.




When done, click the Apply button. On some
adjustments, such as the spacing, you can just
hit ‘Enter’ on your keyboard, and the program
applies the changes.

Text to Stairs Properties

The properties of the selected Text to Stairs
segment can be adjusted by way of the Stairs tab
on the Properties box.

Properties
TStairs| TextExtra Fill Underlay Pull comp. 4 b
|Stairs
Font []1e
ﬁa@b 4 0 Adalynn - E]
Height (mm): Width 8):
200 100.0 Style: | Defautt _v]
Spacing: Slant
S %]
Line angle:
45 —
|__aepy__ |

Along the top of this tab is a field for entering the
desired text string. Also, you will find fields for
adjusting the text’'s Height, Width percentage,
Spacing, and Slant. For details on these
properties, refer to the appropriate sections
under “Editing Text in the Properties Box.”

There is one field on this tab that is unique to
Text Stairs: Line Angle. This property determines
the angle that the lettering follows (the slope of
the virtual “staircase”). This value is 45° by
default, but it can be adjusted to any angle. An
angle of 0° will be straight along the baseline
(horizontal), and a negative angle will go up.

FONTWORKS
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Two examples of Line Angle settings.In the left segment,
set to 25°% on the right, set to -25°.

Text Extra Settings

The following settings that are found under Text
extra on the Properties Panel. All of these, with
the exception of Drop Caps, are common to all

types of Text.

Properties
Text |Text Extra, Fill Underlay Pull comp. 4 b
Sew sequence: [ Left vl
Trim type: |Evays v |
Lock type: [Always v ‘
Drop Cap{%): [None v-l 150.0
__Apply

Sew Sequence

This setting determines the position in the text
segment at which the sewing will begin. Choose
either Left, Right or Center.

Trim Type

Use the Trim type field to control how trims are

applied to lettering segments. You can choose

from the following options:

« Always: Inserts a trim between all letters in
the segment.

‘73



74

CHAPTER 5
Properties of Text Segments

» Never: No trims are placed between letters in
the segment.

« Auto: A trim is placed between the letters, if
the distance between them exceeds a certain
set value (in this case, the threshold for
inserting a trim is 3mm).

Lock Stitches

You can choose to add lock stitches to the
lettering using the Lock Type field in the Text
Extra tab of the properties panel. The options are
Always, Never, and Around trim. Click the Apply
to save your changes.

Drop Caps

The Drop Caps setting can be applied to change
the size and vertical alignment of the first letter
of the selected text segment. Note that Drop
Caps is only applicable to text created with the
‘normal’ Text tool.
Notice that if you apply Drop Caps to multi-line
normal Text segments, the first letter of each

line in the segment will be a Drop Cap, which
may not be the desired result.

To create a multi-line segment which has a
' Drop Cap in the first line only, do this: divide it
° up into two different Text segments — one for

the first line of the text (which you apply Drop
Caps to), and another for the second and
subsequent lines of text (which does not have
Drop Caps applied to it).

There are two settings that you can set with Drop
Caps. One is the Alignment setting, which
determines the position relative to the baseline

followed by the text segment. Choose either
baseline, top, or center.

Drop Cap(%):

None |
Baseline
Top ‘
Center
|__Apply__|

The other property for Drop Caps is the Size
property. This determines how much larger or
smaller the drop cap letter will be, compared to
the base lettering. This setting is expressed as a
percentage, with 100% being equal in size to the
main lettering.

Note that not all fonts support Drop Caps; if
the selected font is not one of those that do,
v the Drop Caps field will be grayed out.

Fill Settings

If the text Style is set to “Default” or “Default with
Run” there will be certain properties, specific to
fills, which can be adjusted in the Properties box.
First, you will be able to select the type of fill
pattern that is applied to the lettering (Standard
or Fancy); then, you will be able choose which
pattern to apply from the drop-down list.

You can also set the stitch length and the density
of the fill stitches on the Fill tab.

Fill type and pattern

You have the option to change the pattern of the
fill in your lettering. You can choose between a
list of Standard Fills or Fancy fills. Additionally,
you can modify the properties of your fill under
the Fill tab.

»  Note that not all fonts have the ability to
/‘ change fill patterns.



Stitch Length

When you create a Text segment, there is a
default stitch length assigned to the font’s fill.
You can change this length for the given
segment by checking the Stitch length box on the
Fill tab of the Properties box, and typing in a new
value for the length in the Stitch Length box.

Density setting

Fill density is the distance between individual
lines of embroidery. Density in embroidery is
measured in ‘Stitch Points’ where each point is
equal to 0.1 millimeter.

How does changing this setting affect your
design? If you have a very loosely woven fabric,
you may want to use a slightly larger number. Do
this because the fabric may not be able to hold a
large set of stitches in a small area.

®  |tis important to always stitch a test before
committing to a design.

For larger text items, particularly when you
exceed the maximum recommended height of a
font, you will probably want to use Fill stitches.
Fill stitches are the type you would normally find
filling an area in a typical embroidery design.
With Fill Stitches, each line across is made up of
two or more individual stitches.

If you are unsure what setting to use, try the
standard setting, 0.4, which works well for many
fonts, as long as you haven't exceeded the fonts
size recommendations.

The image next to the Density setting on the Fill
tab will change as you adjust the setting. These
are not precise images given in the Fill tab; they
are intended to illustrate how the density
changes according to the value that you set.

A general rule is to use full-fabric coverage,
but add extra stabilizer if you want to support a
high-density fill on a low-density fabric.
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Changing Fancy Pattern
settings

In the Properties panel, you can change a Fancy
pattern by adjusting settings in the Properties
box. The settings allow you to change a fill
pattern’s characteristics such as the size of the
fill pattern.

The following figure shows an example of the
effect of the Emboss Scale Fancy Fill settings.

Original - scale at 100% Emboss scale at 150%

#  The Emboss scale setting is limited to values
,‘ ' between 50% and 200%.

To change the characteristics of a Fancy

pattern:

1 Select the Fancy Fill text segment.

2 In the Properties box, click the Fill tab.

3 In the Fancy Scale box, enter a percentage
value to adjust the scaling.

4 Click Apply.
You see your segment altered accordingly.

Choosing a Fancy pattern

When you install FontWorks, a number of Fancy
patterns are installed on your computer. You can
select a Fancy pattern in the Properties box.
Fancy patterns create a grooved or chiseled
effect for the designs that you create.

To choose a Fancy Fill pattern:

1 Select the Fancy Fill segment.
2 In the Properties box, click the Fill tab.
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3 From the Pattern list, select a pattern.
4 Click Apply.
Your fancy fill segment is altered accordingly.

Pull Compensation
Settings

You can adjust the pull-compensation in your
design. You use the settings from the Pull Comp

Properties box to adjust the pull-compensation.
Choose from None, Percentage, and Absolute.

To adjust the pull-compensation:
1 Select the segment.

2 Inthe Properties box, click the Pull Comp tab.

3 From the Type list, select one of the following
options:

+ None. Makes no adjustments to pull-
compensation.

+ Percentage. Enter the percentage in the
value % box and, if necessary, enter the
maximum value of pull-compensation in
the Maximum range box.

»  You can also adjust the value % number using
/% the value % slider.

+ Absolute. Enter the amount of absolute
pull-compensation in the Absolute value
box.

4 Adjust any of the other settings. Refer to the
related procedures for more information.

5 Click Apply.
You see the segment altered accordingly.

Text Styles Option

For those fonts that support it, there is the option
to change the style of the embroidery that is
used to draw your lettering. Text Styles is an
option which you can use to expand the creative
possibilities of embroidery lettering.

»  Note that the Style property does not apply
to TTF Text segments.

The Default style that will be applied to any
segment created with any of the text tools is the
fill stitch, by itself (Standard or Fancy fills).

However, for certain fonts (which are marked

with a special icon in the list, like this: © Fabian)
you can also choose from among the following
other styles to apply to your lettering: Run, Satin,
Applique, Spiral, Trapunto, or Default with Run.

' Note that not all of these Styles will be
available for every font.

Note, too, that the each of the styles has its own,
unique Properties tab. The following sections
give a description of each Style, and the settings
that pertain to it.

Run Style Text

When you apply the Run style to the text
segment, it converts the outline of the lettering to
a run stitch.

There are four different possible Run types;

single, double, bean, and motif.

- A Single Run stitch is a simple forward-
moving stitch that looks like any straight
stitch produced by a sewing machine.

+ A Double Run stitch sews over the line twice:
once forward, and once backward, thus it
ends up where it starts.



» The Bean stitch is also known as a Three Ply
stitch and is a running stitch where the
machine sews over each stitch three times
(forward, back, forward again) before it
moves to the next stitch. The result is a heavy
running stitch.

« The Motif Run is a decorative, programmed
stitch. When you select a Motif run, the list of
Motif patterns at the bottom of the Run area
in the Properties becomes active. Scroll down
the list to select the Motif you want.

Satin Style Text

The Satin Style uses a satin stitch to follow the
outer contour of each letter. The properties
specific to Satin are width and density.

SHTIN

The Default lettering properties fill, underlay,
» and pull-compensation) also apply to Satin.
.-L For more information about these properties,
see “Changing Lettering Properties”.

Applique Style Text

If you need to create large letters for a design,
Applique Style text is one way to reduce the
number of stitches required. With Applique
lettering, you use cut pieces of fabric in place of
large fill stitch areas.

APPLICULE
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There are three different embroidery segments
for each letter in applique style text:

+ Positioning stitches. These sew onto the
garment first, and serve as a guide for
placing the applique fabric.

« Tack-down stitches. Once you have place the
applique fabric, the tack-down stitches hold it
in place.

« The Applique border. Border stitches run all
the way around the outline of each letter to
securely attach the Applique fabric to the
garment.

Applique Border Settings

There are three different kinds of Applique
border stitches: Satin, Motif, and Blanket. For
more information about the settings for each of
these types, see the procedures for each type,
below.

Applique settings — Satin

After you select the Applique stitch type, you can
adjust any of the default settings available.

To adjust satin stitch settings:

1 Select the Applique text segment.

2 In the Properties field, select the Applique
tab.

3 Inthe Applique type field, select Satin.

4 In the Stitch length field, enter the stitch
length of the positioning and tack down runs.

5 In the Applique width field, enter the width of
the satin stitching.

6 Inthe Applique density field, enter the density
of the Satin stitching.

7 Inthe Applique inset field, set the percentage
that the satin stitch border will be inset
relative to the original outline. This setting
determines by how much the satin stitches
overlap the Applique fabric.
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For Applique with a satin border, the default
»  setting is 50%; effectively, this means that the
/% satin stitches will be half on the Applique
fabric, and haif on the underlaying fabric.

8 (Optional) Click the Applique fabric field to
show a preview image of a fabric inside the
Applique.

Select from a the list of installed fabrics, or

click the Q button to browse for a different
image to display.

9 Click Apply.
You see the segment altered accordingly.

Applique settings — Blanket

After you select the Applique stitch type, you can
adjust any of the default settings available.

Blanket stitch borders have one unique property.
You can vary the length of every second inset
stitch in the border, so that it is shorter than the
adjacent stitches (like the middle stroke in an
“E”). This is set as a percentage of the original
stitch length.

To adjust blanket settings:

1 Select the Applique text segment.

2 On the Properties panel, select the Applique
tab.

3 From the Applique type list, select Blanket.
You can adjust any of the default settings that
are available for the Blanket stitching.

%  You must make all changes to Blanket stitching
/% in the Applique box.

4 In the Stitch Length box, enter the stitch
length of the positioning and tack down runs.

5 In the Applique width box, enter the width of
the Blanket stitching.

6 In the Blanket density box, enter the spacing
for the Blanket stitching.

7 Inthe Applique E Center box, set the
percentage that the “middle” stitches will vary
from the regular blanket stitch length.

®  The E Center value can vary between
s 0-100%.

8 (Optional) Click the Applique fabric field to
show a preview image of a fabric inside the
Applique.

Select from a the list of installed fabrics, or

click the E] button to browse for a different
image to display.

9 Click Apply.
You see the segment altered accordingly.

Applique settings — Motif

If you select a Motif stitch for the Applique
border, you can adjust any of the default settings
available.

To adjust motif settings:

1 Select the Applique segment.

2 In the Properties panel, select the Applique
tab.

3 From the Applique type list, select Motif.

You can adjust any of the default settings that
are available for the Molif stitching.

4 In the Stitch Length box, enter the stitch
length of the positioning and tack down runs.

5 From the Motif list, select a Motif pattern that
will be used as the Applique stitching.

6 In the Motif stitch length box, enter the motif
stitch length. The motif stitch length affects
the size of the motif and represents the
length (width) of each motif pattern.

7 In the Applique inset box, set the percentage
that the motif stitch border will be inset
relative to the outline of the original Applique
segment. This setting determines by how
much the motif stitches overlap the Applique
fabric.



For Applique with a motif border, the default
» inset setting is %50; effectively, this means
I‘ that the motif stitches will be half on the
Applique fabric, and half on the underlying
fabric.

8 (Optional) Click in the Applique fabric field to
show a preview image of a fabric inside the
Applique.

Select from a the list of installed fabrics, or
click the button to browse for a different

image to display.
9 Click Apply.

Changing colors in
Applique Text

In order to stop the machine so that you can
place the fabric pieces to be sewn on to the
garment, the Applique Style lettering segment
inserts a color change between each positioning,
tack-down, and border segment. This means
that, when first generated, the lettering segment
will display many colors.

You can change the colors of lettering in a
Applique segment by selecting a color from the
list on the Color Palette.

To change the color of letters in an
Applique Text segment:

1 Select the Applique Text segment.

_%@

2 Inthe color palette, find the color you wish to
apply to the first of the letter of segment, and
click on it.

You see the a menu of colors.
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i ‘| Colorl

| Color2
Color 3

I. Colord
Hi" Color5

Color6
I Color?

3 To set the color of the first letter, in the
Options menu, click on Color 3. (In the first
letter of an Applique-style text segment,
Color 1 refers to the positioning stitches, and
Color 2 to the tack-down stitches; Color 3 is
the thread color of the visible border
stitches).

The first letter changes to the chosen color.

4 Choose the color you wish to apply to the
next letter and click on it.

[ [ [ o]
Colorl
Color 2

Color 3

Color4
Color 5

Color6
Color7

|
I
|
I
I
J
|
I
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5 From the menu, click on Color 5. (For the
second letter of the applique segment, the
positioning stitches will be sewn using thread
color 3, and the tack-down stitches color 4).
The second letter will change to the chosen
color.

6 Repeat steps #4 and #5 for each letter in the
segment, changing every other color in the
applique segment, until you have changed all
the colors required.

Adding a fabric back-
ground to Applique text

You can now specify a fabric background to
display within the border. You can select either
from a list of fabric images provided with
FontWorks, or import your own image file to use
as a background.

To display a fabric background in an

Applique segment:

1 Select the Applique segment.

2 Open the properties box and select the
Applique tab.

Properties
Text TextExtra [Applique 4

Applique type: l Satin v |
Stitch length (mm): 35
Applique width [mm]: 25
Applique density mm): 0.4
Applique inset (%) 50.0
Applique Fabiic:  Fabric02 v [l ]

|_ Apply |

3 Click the down arrow next to the Applique
Fabric list to see the available fabrics, and
choose one from the list.

4 Click Apply.
The selected fabric image appears within the
Applique border.

The fabric image you apply in the Properties
box will also be visible in the print-out of the
design.

f

To import an image for an Applique

background:

1 Select the Applique segment.

2 Open the properties box and select the
Applique tab.

3 Click the browse | [ button next to the

Applique Fabric list.
The Import Fabric dialog will open..

The Appligue fabric images are located in the
/I folder C: Program Files/Baby Lock/FontWorks/
; Fabric/Applique.

You can also scan your own fabrics as images
for use in your design projects. For best
results, scan them with a resolution of 300 dpi.
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4 Browse to the location of the image you wish
to use as a fabric.

5 Select this image and click Open.
The image appears within the Applique
border, and it is added to your Applique Fabric
list.

The fabric image you import will also be visible
in the print-out of the design.

Trapunto Style Text

The Trapunto style is much like the Run style, in
that the letters are made up of a series of a
series of run stitches. In this style, however,
there are also three outlines stitch segments
added, as shown below.

The offsets for this text style are preset in the
software, and depend on the size of the lettering.
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The stitch length of the Trapunto stitches,
however, can be adjusted; in the Properties
Panel, select the Trapunto tab, and then type the
new value in the Stitch Length field. Click Apply.

Spiral Style Text

The Spiral text style creates spiral run stitches
that follow the outline of the letters in the text.

Vv
LIS
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,
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When you create a Spiral Style text, the Spiral
Text tab will open in the Properties tab. On this
tab, you will be able to adjust the stitch length of
the spiral stitches, and the density of the spirals.
Note that, for spiral stitches, a lower density
value corresponds to a higher number of spirals
in the pattern.

Click Apply to save the changes.

Default with Run Text Style

The Default with Run style is comprised of two
different stitch types applied to the same text
segment — a default (fill) stitch, and a run stitch
which traces the outline of the segment. Both
parts will be sewn with the same color of thread.
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When you select a Default with Run - style text
segment, you will see that both the Run and the
Fill tabs will appear on the Properties panel. By
selecting these tabs, you can adjust the
properties for the Run and Fill parts of the
segments.

For details, see "Run Style Text” and “Fill
Properties.”

Underlay Properties

Selecting the Underlay type
You can select Underlay types for various types

of stitches. Choose from Contour, Parallel,
Perpendicular, or Zig-Zag.

You can combine Underlay types to get
maximum coverage.

To select an Underlay type:
1 Select the segment.

2 |n the Properties box, click the Underlay tab.
3 Select one or more of the following Underlay
types you want to use: Contour, Parallel,

Perpendicular, or Zig-Zag.

When you select Underlay types, you will be
»  able to see what your Underlay type will look
/% like in the Preview area. Note that not all types
of Underlay can be applied to every font.

4 Adjust any of the other settings.
5 Click Apply.

Specifying the Underlay
Density

You can specify the density for Underlay
stitches.

To set the Underlay density:
1 Select the segment.

2 In the Properties box, click the Underlay tab.
3 Select one or more of the following Underlay
types you want to use: Contour, Parallel,

Perpendicular, or Zig-Zag.

When you select Underlay types, you will be
¥  able to see what your Underlay type will look
_,3 like in the Preview area. Note that not all types
of Underlay can be applied to every font.

4 In the Density box, enter a density value.

5 Adjust any of the other settings. Refer to the
related procedures for more information.

6 Click Apply.

Specifying the Underlay
stitch length

You can specify the stitch length for your
Underlay stitches. You can increase or decrease
the length according to your Underlay needs.

To specify the Underlay stitch length:
1 Select the segment.

2 In the Properties box, click the Underlay tab.
3 Select one or more of the following Underlay
types you want to use: Contour, Parallel,

Perpendicular, or Zig-Zag.

When you select Underlay types, you will be
% able to see what your Underlay type will look
/% like in the Preview area. Note that not all types
of Underlay can be applied to every font.

4 In the Stitch Length box, enter the stitch
length that you want for your Underlay
stitches.

5 Adjust any of the other settings. Refer to the
related procedures for more information.

6 Click Apply.
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Changing the inset distance

You can change the inset distance. FontWorks
calculates the inset distance (the distance the
Underlay stitches are placed from the edge of
the top stitching.) Inset distance changes the
amount of Underlay coverage. The smaller the
inset distance, the more coverage you have.

To change the inset distance:
1 Select the segment.

2 In the Properties box, click the Underlay tab.
3 Select one or more of the following Underlay
types you want to use: Contour, Parallel,

Perpendicular, or Zig-Zag.

When you select Underlay types, you will be
®  able to see what your Underlay type will look
/5 like in the Preview area. Note that not alf types
of Underlay can be applied to every font.

4 In the Inset box, enter the amount of distance
you want.
Enter a zero value if you want to place the
Underlay directly on the edge of the segment.

5 Click Apply.
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CHAPTER 6

Design Editing

You can Resize, Rotate, Flip or Distort segments in a few easy steps. Using
the properties panel you can rotate selected objects, and change their thread
colors using the color palette.

In this chapter:

* How to edit, copy and move segments.
» Adding embroidery embellishments from the Designs tab.
» Sequencing outline segments to change the sewing order of designs.
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Editing Segments

In the design window, you can edit a design’s
text segments, when they have been selected

with Select k tool.

Typically, when you modify segments in a
design, the program will not regenerate stitches
for the entire design; it will only generate stitches
for the segment being modified.

Selecting segments

The Select _& tool allows you to select and
modify individual or groups of segments (ob-
jects). You select outline segments by clicking on
a single segment or by clicking and dragging to
draw a box around parts of the design.

Once you select a segment, you can change its
properties using associated edit menus and tabs
as well as the bead attached to the segment’s
selection box.

To select segments with the Select tool:

1 Click the Select ,k tool.
2 To select one segment, do one of the
following:

+ Click the segment you want to select.

+ Click and drag to select the segment you
want.

The active segment is enclosed in a selection

box with handles.

3 To select multiple segments, do one of the
following:

+ Click and drag across all the segments
you want to select.

+ Click a segment. Press CTRL on your
keyboard while you click each segment
not already selected.

The active segments are enclosed in a

selection box with handles.

4 To edit or change the properties of the
segments, do the following:
¢ Right-click and choose any of the options
available in the edit menu.
+ In the Properties box, alter any property
settings as required.

To select segments from the Design
Sequence:

1 Click the Select k tool.
2 In the Design Sequence area, browse to find
segments grouped by a given color.

Design Sequence X

All items
= 5L«4 1. Madeira Thread Chest 1243 Deep Arctic Sky
‘ El gA LWL Text

| #1 Madeira Thread Chest 1243 Deep Arctic Sky

=3 Madeira Thread Chest 1250 Emerald Green
;\@ 4, Madeira Thread Chest 1257 Dark Maple
7] 5\%& 5. Madeira Thread Chest 1145 Mahogany

E] ;,‘ 6. Madeira Thread Chest 1379 Orange Red

4 m 3

Properties | Design Sequence  Color Palette Designs

3 To select one segment, click the segment
from the list.

In the design workspace, the active segment

is enclosed in a selection box with handles.

4 To select multiple segments within the Design

Sequence area, do any of the following:

+ Click a segment. Press CTRL on your
keyboard while you click each segment
not already selected.

+ Click a segment at the start of your
selection. Press Shift on your keyboard



while you click the segment at the end of
your selection. To extend the range of
selected segments, press Shift again or
Shift+CTRL while you click any segment
outside the range of segments already
selected.

In the design workspace, the active segments

are enclosed in a selection box with handles.

5 To edit or change the properties of the
segments, do any of the following:

+ In the design workspace, right-click the
segment(s) and choose any of the options
available in the edit menu.

+ |In the Design Sequence area, right-click
the segment(s) and choose any of the
options available from the menu.

+ In the Properties box, alter any property
settings as required.

Naming individual segments

Once you have found a particular segment by
clicking on it, you may want to give it a unique
name so that you can pick it out of the Design
Sequence area more easily.

To name segments:

1 Inthe Design Sequence area, select an
individual segment.

If the segment is part of a group, you will need
to expand the branch (if it is not already open)
to select the individual segment you want to
rename.

To do this, click on the ‘+' in front of the group,

then look for the segment in the expanded list.

2 Do one of the following:

+ Right-click the name of the segment and
select Rename from the menu.
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All items

Ey;a 1, Madeira Thread Chest 1243 Deep Arctic Sky

= AL Show All
#1 Ma Hide Other c Sky
Rename I
Collapse all h f
23 Mat| Expand all Feeh

+ Click on the name of the segment. Then
click the name again.
The segment name becomes editable.
All items
= 5;‘-\1..-4 1. Madeira Thread Chest 1243 Deep Arctic Sky

v (] |

#1 Madeira Thread Chest 1243 Deep Arctic Sky
=3 Madeira Thread Chest 1250 Emerald Green
3 Enter the new name for the segment.

4 To finish, do one of the following:
¢ Press Enter on your keyboard.

+ Click anywhere on the design workspace.

Copying segments
You can use a number of methods to copy
segments in your designs.

To copy to the Clipboard:
1 Select one or more segments you want to
copy.

2 To copy segments to the clipboard, do one of
the following:

¢ On the Home tab, click Copy in the

Clipboard menu.
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*

In the design workspace, right-click the
segment(s) and choose Copy from the
menu.

In the Design Sequence area, right-click
the segment(s) from the list and choose
Copy from the menu.

3 To paste segments from the clipboard, do one
of the following:

*

In the design workspace, right-click
anywhere and choose Paste from the
menu.

The selection is pasted in its original
location.

In the Design Sequence area, right-click
where you want to paste the segments
and choose Paste from the menu.

The selection is pasted where you wanted.

You can also use Paste ;_ or press Ctrl+V to

paste segments.

To cut to the Clipboard:

1 Select one or more segments you want to cut.

2 To cut segments to the clipboard, do one of
the following:

*

In the design workspace, right-click the
segment(s) and choose Cut from the
menu.

In the Design Sequence area, right-click
the segment(s) from the list and choose
Cut from the menu.

The segments are removed from their
placement.

3 To paste segments from the clipboard, do one
of the following:

>

*

In the design workspace, right-click
anywhere and choose Paste from the
menu.

The selection is pasted in its original
location.

In the Design Sequence area, right-click
where in the list you want to paste the

segments and choose Paste from the
menu.
The selection is pasted where you wanted.

You can also click Paste f_ or press Ctrl+V
on your keyboard to paste segments.

Deleting segments

Deleting a segment removes it from the design.
The only way to retrieve a segment you delete is

to choose Undo V73] too! from the Quick Access
tool bar (or press Ctrl+Z) immediately after you
delete it.

To delete a segment:

1 On the Home tab, choose the Select E

tool.
2 Select the segment.
3 There are three ways to delete a segment:

*

*

Press Delete on your keyboard.

On the Home tab, click the Delete 7<
tool in the Clipboard area.

Right-click and select Delete from the
shortcut menu.



Showing and hiding
segments

You can show and hide segments and segments
grouped by color using the Design Sequence
area.

To hide unselected segments:

1 From the Design Sequence area, select the
segment or segment group based on color
from the list.

2 Right-click and choose Hide Other from the
menu.

In the design workspace, you no longer see

any of the unselected segments in the design.

To show all hidden segments:

« From the Design Sequence area, right-click
any segment and choose Show All from the
menu.

In the design workspace, you see all
segments in the design.

Moving through a Design by
Segments

Once you are in Outline Mode, FontWorks makes
it easy to move through an Qutline design.

To move through an outline design by
increments:

1 On the Home tab, click the Select E tool.
2 In the Design Sequence area, select a
segment from the list.
3 On your keyboard, press any of the following
keyboard shortcuts:
¢ Ctrl+Arrow Up = move backward by one
segment.
¢ Ctrl+Arrow Down = move forward by one
segment.
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Reflecting segments

Reflecting a segment flips the object across an
invisible axis.

To reflect segments:

1 Select the segment(s) you want to reflect.
2 In the Modify area of the Tools tab, click one
of the following:

+ Click the Flip Vertical = tool to flip
selected objects vertically.

* Click the Flip Horizontal [ tool to flip
selected objects horizontally.

The segment or segments are altered
accordingly.

Aligning segments
horizontally and vertically

You can align lettering or segments horizontally
or vertically. You can use this feature to precisely
align lettering at the center of a design.

18 [Jo

Top Center

Co

Bottom

Vertical alignment

[ ] L1 L]
0§ g

Left Center Right

Horizontal alignment
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To align segments:
1 Select the segments you want to align.
2 On the Home tab, click any of the following:

Left: Moves all selected objects except the
left-most item selected.

Right: Moves all selected objects except the
right-most item selected.

Bottom: Moves all selected objects except
the bottom-most item selected.

Top: Moves all selected objects except the
top-most item selected.

= = b P

Vertical Center: Takes all selected objects

and centers them in the selection box. The

objects are moved so that they are centered
top-to-bottom with each other, but they are

not moved left or right.

=

Horizontal Center: Takes all selected
objects and centers them in the selection
box. The objects are moved so that they are
centered left-to-right with each other, but
they are not moved up or down.

o

Center: Centers one or more selected
objects proportionally in the design work-
space.

Resizing segments

Resizing a segment enlarges or reduces it
horizontally or vertically, relative to the
percentage you designate. You can manually
resize segments or use the Transform tab
settings available for finer control.

Only items created in FontWorks can be

resized using the Transform tab; this includes

segments created with any of the text tools,

and designs that are imported from the

/h Designs tab. Any other embroidery designs
that are imported into the program (e.g. by way
of the Merge Design feature) may not be
resized in FontWorks.

To resize segments manually using design
handles:
1 Select one or more segments.

The active segment(s) is enclosed in a

selection box with handles.

2 Do one or more of the following to resize
segment(s):

+ To resize segment(s) by width, click and
drag the design handles located on the
left and right side of the selection box.

+ To resize segment(s) by height, click and
drag the design handles located on the
top and bottom sides of the selection box.

+ To resize segment(s) proportionally, click
and drag the design handles located at
the top or bottom corners of the selection
box.

To resize segments using the Transform

tab:

1 Select one or more segments.

The active segment(s) is enclosed in a
selection box with handles.

2 In the Properties box, click the Transform tab.

3 In the Width box, enter the width you want for
the selected object(s).

4 In the Height box, enter the height you want
for the selected object(s).

5 To maintain the proportions of an object while
resizing it, select Maintain aspect ratio if not
already selected.

6 Click Apply.



Rotating segments

Rotating a segment turns it around a fixed point
that you determine. Rotating a segment is useful
if your design contains elements that are rotated
to the same angle, such as a logo and lettering
displayed on a 30° angle.

NN

To rotate segments manually:

1 Select one or more segments you want to
rotate.

The active segment(s) is enclosed in a
selection box with handles.

2 Move your mouse over the blue rotation bead
beside the top-right or the bottom-left design
handle.

You see the cursor change to a circular arrow.

3 Click and drag the rotation bead to adjust the
box to the angle you want.

%  You can see the degrees of your rotation angle
_,5 on the status line in the bottom left corner.

To rotate segments using the Modify tools:
1 Select one or more segments you want to
rotate.

The active segmenl(s) is enclosed in a
selection box with handles.
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2 On the Tools tab, select either of the
following:

Rotate Left: Rotates one or more selected
objects to the left by 90° increments.

D

Rotate Right: Rotates one or more selected
objects to the right by 90° increments.

To rotate an object from the Transform tab:

1 Select one or more segments you want to
rotate.
The active segment(s) is enclosed in a
selection box with handles.

2 In the Properties box, click the Transform tab.

3 In the Rotate box, enter the number of
degrees you want to rotate your design.

4 Click Apply.

Distorting segments

Distortion, also called morphing, takes a set of
stitches and moves them all around in a pattern:
It distorts the design. Distortion works with
working files (*.BLF) and stitch files.

In FontWorks, you can choose from several
distortion effects for your designs. Each effect
has available adjustments: these are Frequency,
Amplitude, Angle, Radius and Scale. As you
manipulate the controls for these effects, the
result is displayed in a preview inside the
Distortion dialog.

9
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Distortion Controls: Frequency

The Wave and ZigZag distortions add a series of

‘ripples’ to the selected objects. The number of
the ripples is controlled by the Frequency
setting. Here is an example of a single ripple
(lowest frequency setting). It looks like the
design is going around a corner:

Distortion Controls: Angle

The Twirl effect uses an angle setting to
determine how much ‘twist’ the design will be

given.

Distortion
Siyle Preview:
g i '.
ol || S
|P|nr:h‘ze -
‘sphev ‘ ’No‘“‘\%
Yogtt g .MM%\
Y S S
Andle: D b‘\‘ rf"
o
Ok | | Concel |

Distortion E
Style Praview:
s Sy —
Wave
Tl
Ek‘l';:h
phetize i e P
= -.‘!aw_a& I‘;_,.,;ﬁ..f ?.2.'_
.
Dj jonz
-
Frequency: D SC 1St0ﬁ10n:‘?
St g g_q.‘,x"ﬁ
| 0K | Cancel |

Distortion Controls: Amplitude

Going back to the ‘ripples’ concept, the
amplitude is the height of the ripples. Here is the
same example, but with an increased amplitude:
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Distortion Controls: Radius

The Pinch effect takes the middle of the design
and stretches it so that it looks like a ball. The
radius of this ball is controlled by the radius
setting. Here is a pinch with a large radius:
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Distortion Controls: Scale

The scale is also used by the Pinch effect. It
controls how much to expand the ‘ball’. The
previous picture shows a high scale. The picture
below is an example of a low scale:
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To distort segments:
1 On the Quick Access toolbar, select Open

Design ¥ to open an existing design.
You see your existing design file.

2 Select one or more segments you want to
distort.

3 From the Tools tab, click the Distortion 'g

tool.
You see the Distortion dialog appear with
selected segments displayed in the preview
window.

4 In the Style area, select the distortion style
you want.
You can see each style applied to your
segments in the preview window.

5 Adjust any of the distortion controls
accordingly.

6 Click OK.
You see selected segments altered
accordingly.
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Moving segments

In FontWorks, there are a number of different
methods to move segments in your designs.

Moving segments manually
You can move segments around your design by
dragging them to another location.

You can show and hide grid lines by clicking

' ' the Grid . tool.

To move a segment or a copy of a segment
manually:

1 Click the Select R tool.

2 Select the segment.

3 Click and drag the segment to its new
location.
As you drag, the status line displays the
horizontal (dx) and vertical (dy) distance.

Nudging segments

Nudging moves the selected object (can be
either lettering or design segments) a small
amount in the vertical or horizontal direction.
Nudging is similar to dragging the segment but
the distance that the segment moves is smaller.

To nudge an object:

Click on the Select g tool.
2 Select the object, and do one of the following:

+ To nudge up, press Ctrl + 1‘ )
¢ To nudge down, press Ctrl + J.

+ To nudge left, press Ctrl + <=
+ To nudge right, press Ctrl + .
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Designs Tab

The Designs tab is located to the right of the
workspace, tabbed along with the Properties,
Design Sequence and Color Palette tabs.

On this tab, you will see pre-digitized embroidery
designs, which you can use to embellish the
lettering you create in FontWorks.

Notice that you are able to resize and rotate
these designs, once they have been imported
into the workspace.

For more information, see "“Moving Segments,”
“Rotating Segments,” and “Resizing Segments”.

To place designs using the Designs tab:

1 Create a new *BLF design, or open an
existing design.

2 From the tabs to the right of the FontWorks
workspace, select the Designs tab.
You see a list of available designs, showing a
thumbnail image of each one.

Devigris X

Wil
77.8 x75.0 mm, st:221... 77.0 xB8.7 mm, 5t:165...

R

E XL
w

FWi14
729 x97.9 mm, st:252... 88.8 x98.0 mm, st:349...

W N,

FW17
97,9 x39.0 mm, st:487... 99.4 x45.3 mm, st:278... -

FW10
77.0x74.1 mm, st:138...

Fw13
86.3 x98.0 mm, st:710...

()

98.0 x86.1 mm, 5t:256...

Note that the name of the design, its
dimensions (width = height), the number of
stitches it contains, and the number of thread
colors it has, will all be listed underneath the
thumbnail.

3 Click on the required design to select it, and
then click in the workspace to place it.

When placing the design, you can click and
drag the mouse pointer to determine the
design’s size and orientation.

You will see the design in the workspace; you
will now be able to move, resize and/or rotate
it to suit the rest of your design.

Merging Design Files
You can merge design files into an active design

window. Use the Merge " tool to import a

design, or number of designs, into your currently
open file. You can merge design files using a
variety of file formats such as the Baby Lock
(*.BLF) file, etc.

When you merge a Baby Lock file (*.BLF) into
the unified design window, your single design file
contains both outlines and stitches. When you
merge other files into the unified design window,
your design files open as stitch segments.

To merge designs:

1 Open an existing design, or create a new
design.

2 On the Quick Access toolbar, click the Merge

@ tool.
You see the Merge Stitch File dialog.

3 In the Look in list, browse to the location of
the file you want to merge.

4 In the Files of type list, select a design file
type for the design you want to merge.

5 In the File Name box, select the design file
that you want to merge onto the current open
design workspace.



6 To view a preview of the selected design,
select Preview, if not already selected.
You see a preview image of the selected
design appear on the right-hand side of the
dialog.

7 Click Open.

The merged design file will appear in the
design workspace.

Sequencing Outline
Segments

You can alter the sequence of outline segments
in your designs. You can select individual
segments, and also segments grouped by color,
and move them backwards and forwards in the
sequence, or to the beginning or the end of the
sequence.

Moving a segment forward
or backward

Use the Move Up commands to move the
selected segment closer to the beginning of the
design. You can also use the Move Down
commands to move the selected segment closer
to the end of the design.

See the table below for an example of how to
apply the Move up/Move down commands.
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ABCD

Above, a simple design made up of four separate let-
ters (each an independent segment). The image
directly below shows it in the original sequence.

All items

.E?.A. 1. Madeira Thread Chest 1000 Black
EB 2. Madeira Thread Chest 1000 Black

l 3. Madeira Thread Chest 1184 True Red

Al e

}D 4, Madeira Thread Chest 1000 Black

LW
)

All items

& ﬁA 1. Madeira Thread Chest 1000 Black
e 3‘B 2. Madeira Thread Chest 1000 Black
@ ;D 3, Madeira Thread Chest 1000 Black

= ;C 4, Madeira Thread Chest 1184 True Red

5,ACText

In this case, the Move down command was used to
change the sewing order. Now, instead of sewing in
the order A - B - C - D, which would require two color
changes (from red to graphite and back again) the
letters sew in the order A-B - D - C, and only one

color change is required.

To move a segment forward:

1 In the Select the segment(s).
2 Do one of the following:

95



96 | CHAPTERG®G
Design Editing

+ In the design workspace, right-click the
segment(s) and choose Move—Up.

+ In the Design Sequence area, right-click
the segment(s) in the list and choose
Move—Up.

The selected segment moves one place

earlier in the sequence.

To move a segment backward:
1 Select the segment(s).
2 Do one of the following:

+ In the design workspace, right-click the
segment(s) and choose Move—Down.

+ In the Design Sequence area, right-click
the segment(s) in the list and choose
Move—Down.

The selected segment is moved one place

later in the sequence.

Moving a segment to the
start or end of a design

Use the Move First command to make the
selected segment the first one to be stitched.
When a design is sewn, the first segment sewn is
usually "on the bottom" or in the "back"” of the
design. Use the Move Last command to make
the selected segment the last one to be stitched.
When a design is sewn, the last segment sewn is
usually "on top” or in the "front" of the design.

To move a segment to the start of a design:
1 Select the segment(s) you want to move to
the start of your design.
2 Do one of the following:
+ In the design workspace, right-click the
segment(s) and choose Move—First.
+ In the Design Sequence area, right-click
the segment(s) in the list and choose
Move—First.

Left, the original design; right, after a Move—First
command has been applied the blue “D.”

To move a segment to the end of a design:
1 Select the segment(s) you want to move to
the end of your design.
2 Do one of the following:
¢ In the design workspace, right-click the
segment(s) and choose Move—Last.
+ In the Design Sequence area, right-click
the segment(s) in the list and choose
Move—Last.

Left, the original design; right, after a Move—Last
command has been applied the red “A.”
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